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本文件供已购买 SCIEX 设备的客户在操作此 SCIEX 设备时使用。本文件受版权保护，除非 SCIEX 书
面授权，否则严禁对本文件或本文件任何部分进行任何形式的复制。

本文中所介绍的软件依据许可协议提供。除许可证协议中特别准许的情况外，在任何媒介上复制、修改
或传播本软件均为违法行为。此外，许可协议禁止出于任何目的对本软件进行分解、逆向工程或反编
译。质保条款见文中所述。

本文件的部分内容可能涉及到其他制造商和/或其产品，其中可能有一些部件的名称属于各自所有者的注
册商标和/或起到商标的作用。这些内容的使用仅仅是为了表明这些制造商的产品由 SCIEX 提供以用于
整合到 SCIEX 的设备中，并不意味 SCIEX 有权和/或许可来使用或允许他人使用这些制造商的产品和/
或允许他人将制造商产品名称作为商标来进行使用。

SCIEX 的质量保证仅限于在销售或为其产品发放许可证时所提供的明确保证，而且是 SCIEX 的唯一且
独有的表述、保证和义务。SCIEX 不作任何其他形式的明确或隐含的质量保证，包括但不限于特定目的
的适销性或适用性的保证，不论是法规或法律所规定、还是源于由贸易洽谈或商业惯例，对所有这些要
求均明确免责，概不承担任何责任或相关后果，包括由于购买者的使用或由此引起的任何不良情况所造
成的间接或从属损害。

仅供研究使用。请勿用于诊断过程。
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操作注意事项和限制 1
注释: 在运行系统之前，请仔细阅读本指南的所有部分。

本部分包含与安全相关的一般信息，并介绍了法规遵从性信息。此外，还描述了系统的潜在危
险和相关警告，以及为尽量减少危害而应当采取的预防措施。

除了本部分之外，如需了解与实验室环境、系统和本文档中所用符号和惯例相关的信息，请参
阅以下章节：符号词汇表。有关场地要求，包括主电源、离子源排气、通风、压缩空气、氮气
和低真空泵要求，请参阅文档：《场地规划指南》。

一般安全信息
为避免人身伤害或系统损坏，请阅读、了解并遵守本文件、制造商化学品安全数据表 (SDS)
以及产品标签信息中的所有安全预防措施和警告。这些标签使用国际公认的符号表示。如果未
能注意这些警告可能会导致严重的伤害。

此安全信息的目的是补充联邦、州、省和当地的环境健康和安全 (EHS) 法规。所提供的信息
包括适用于系统操作的系统相关安全信息。它不包括应实行的各项安全程序。因此，用户和组
织有责任遵守联邦、州、省和当地的环境健康和安全法规，维护安全的实验室环境。

请参阅相应的实验室参考材料和标准操作程序。

文档标志和惯例
本指南采用了以下标志和惯例。

危险! 危险表示会导致重伤或死亡的行为。

警告! 警告表示如不遵守注意事项可能会导致人身伤害的行为。

小心: 表示如不遵守注意事项可能会导致系统受损或数据破坏或丢失的操作。

注释: 注释一词突出强调了程序或说明中的重要信息。

提示! 提示在文中针对特定需求提供有助于应用技术和程序的有用信息，以及提供捷径，但对
于程序的完成而言并非必不可少。

合规性
本系统符合本节所列法规和标准。关于注明日期的参考资源，请参阅包含在系统和单个系统组
件中的《符合性声明》。系统上已粘贴适用标签。

操作注意事项和限制
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澳大利亚和新西兰

• 电磁兼容性 (EMC)：如在以下这些标准中执行的无线电通讯法案 1992：

• 电磁干扰－AS/NZS CISPR 11/ EN 55011/ CISPR 11（A 类）。请参阅以下章节：电磁
干扰。

• 安全性：AS/NZ 61010-1 和 IEC 61010-2-061

加拿大

• 电磁干扰 (EMI)：CAN/CSA CISPR11。本 ISM 设备符合加拿大 ICES-001。请参阅以下章
节：电磁干扰。

• 安全性：

• CAN/CSA C22.2 No.61010-1

• CAN/CSA C22.2 No 61010-2-061

欧洲

• 电磁兼容性 (EMC)：如在以下这些标准中执行的电磁兼容性指令 2014/30/EU：

• EN 61326-1

• EN 55011（A 类）

请参阅以下章节：电磁兼容性。

• 安全性：如在以下这些标准中执行的低电压指令 2014/35/EU：

• EN 61010-1

• EN 61010-2-061

• 废旧电子电气设备 (WEEE)：如在 EN 40519 中执行的废旧电子电气设备指令 2012/96/
EEC。请参阅以下章节：废弃电子电气设备。

• 包装与包装废弃物 (PPW)：包装与包装废弃物指令 94/62/EC

• 关于限制在电子电气设备中使用某些有害成分的指令 (RoHS)： RoHS 指令 2011/65/EU

美国

• 无线电发射干扰条例： 47 CFR 15，在 FCC Part 15 (A 类) 标准中实行

• 安全性： 职业安全和健康条例－29 CFR 1910，在这些标准中实行：

• UL 61010-1

• IEC 61010-2-061

国际

• 电磁兼容性 (EMC)：

操作注意事项和限制
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• IEC 61326-1

• IEC CISPR 11（A 类）

• IEC 61000-3-2

• IEC 61000-3-3

请参阅以下章节：电磁兼容性。

• 安全性：

• IEC 61010-1

• IEC 61010-2-061

电气注意事项

警告! 触电危险。切勿拆除保护盖。拆除保护盖可能会导致人员受伤或系统故障。
进行例行维护、检查或调整时不需要拆下保护盖。当修理需拆下主盖时，请与
SCIEX 现场服务人员 (FSE) 联系。

• 遵循所要求的电气安全工作实践。

• 按照电缆管理实践控制电气电缆。这将会降低绊倒危险发生的可能性。

有关系统电气规格的信息，请参阅文档：《场地规划指南》。

主电源

按照本指南的说明将系统连接到兼容的主电源。

警告! 触电危险。所有电气线路和固定装置只能由专业人员负责安装，并确保所
有安装均遵循当地法规和安全标准。

警告! 触电危险。确保在紧急情况下可从主电源插座断开。不要挡住主电源插
座。

警告! 触电危险。仅使用随系统提供的主电源电缆。请勿使用未为本系统运行而
进行适当评级的主电源电缆。

质谱仪或低真空泵无需外部变压器。

保护接地导体

主电源必须包括正确安装的保护接地导体。在连接本系统前，必须由合格的电气技师安装或检
查保护接地导体。

警告! 触电危险。不要故意断开保护接地导体。任一保护接地导体断开都将造成
触电危险。

操作注意事项和限制
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警告! 触电危险。确保在样本定量环和离子源上的适当接地点之间连接保护接地
导体（接地电缆）。该补充接地强化了 SCIEX 规定的安全配置。

化学品注意事项

警告! 电离辐射危害、生物危害或有毒化学品危害。在清洁或维护质谱仪之前，
确定是否需要去污。如果系统使用了放射性物质、生物制剂或有毒化学品，则
在清洁或维护之前客户必须先消除系统污染。

警告! 刺伤危险、电离辐射危害、生物危害或有毒化学品危害。如果离子源窗口
有裂痕或破损，请停止使用离子源，并与 SCIEX 现场服务人员 (FSE) 联系。设
备中引入的任何有毒或有害材料均会存在于离子源排气输出中。设备产生的废气
应从室内排出。请按照既定实验室安全程序处置锐器。

警告! 环境危害。请勿按照城市垃圾处置方式来处置系统组件。处理组件时，请遵
循当地法规。

警告! 生物危害或有毒化学品危害。将排放管线恰当地连接到质谱仪和离子源废
气排放瓶，以防止泄漏。

• 在维修和定期维护前，确定系统中已经使用了哪些化学品。有关必须遵守的化学品健康和
安全注意事项，请参阅文档：安全数据表。有关存储信息，请参阅文档：分析证书。要查
找 SCIEX《安全数据表》或《分析证书》，请转到 sciex.com/tech-regulatory。

• 一定要穿指定的个人防护设备，包括无粉手套、防护眼镜和实验室外套。

注释: 建议使用丁腈或氯丁橡胶手套。

• 在通风良好的区域或通风橱内工作。

• 当工作中用到易燃材料，如异丙醇、甲醇和其他易燃溶剂时，请避免火源。

• 要小心地使用和处置任何化学品。如果不遵循处理和处置化学品的适当程序，就会存在人
身伤害的潜在风险。

• 清洗过程中应避免皮肤接触化学品，使用后洗手。

• 请确保所有排气软管均正确连接，且所有连接和功能均按设计进行。

• 收集所有废液并将其按有害废弃物处置。

• 请遵守关于生物危害性、有毒和放射性物质的存储、处理和处置的所有当地法规。

• （建议）在低真空泵、溶剂瓶和废液容器下面使用二次防护托盘收集可能的化学溢出物。

系统安全液体

可以在系统中安全地使用以下液体。关于安全清洗液的信息，请参阅章节：必需材料 。

操作注意事项和限制
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小心: 潜在的系统损坏。在收到 SCIEX 确认液体不会造成危害的通知之前，不得使用
任何其他液体。这不是一份详尽的清单。

注释: 对于 LC 流动相，只使用新鲜制备的 LC-MS 级或更高等级的溶剂。

• 有机溶剂

• LC-MS 级乙腈；高达 100%

• LC-MS 级甲醇；高达 100%

• LC-MS 级异丙醇；高达 100%

• LC-MS 级或更高等级水；高达 100%

• 乙腈；最高 100%

• 甲醇；最高 100%

• 异丙醇；高达 100%

• DDI 水：高达 100%

• 四氢呋喃；高达 100%

• 甲苯和其他芳香族溶剂；高达 100%

• 己烷；高达 100%

• 缓冲液

• 乙酸铵；低于 100 mM

• 甲酸铵；低于 100 mM

• 磷酸盐；低于 1%

• 酸和碱

• 甲酸；低于 1%

• 乙酸；低于 1%

• 三氟乙酸 (TFA)；低于 1%

• 七氟丁酸 (HFBA)；低于 1%

• 氨/氢氧化铵；低于 1%

• 磷酸；低于 1%

• 三甲胺；低于 1%

• 三乙胺；低于 1%

通风注意事项
烟气排放和废物处置必须遵守所有联邦、州、省和当地的健康和安全法规。客户应确保按照当
地健康和安全法规的要求保持空气质量。

操作注意事项和限制
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质谱仪离子源废气排放系统和低真空泵必须连接到专门的实验室通风橱或外部排气系统。

警告! 火灾危险。确保离子源废气排放系统已连接和正在运行，以防止易燃蒸汽在离子
源中积聚。

警告! 电离辐射危害、生物危害或有毒化学品危害。请小心将废气排至专门的实
验室通风橱或排气系统，并确保通风管道已用夹子固定牢靠。确保实验室具有
适合所执行工作的适当换气措施。

警告! 电离辐射危害、生物危害或有毒化学品危害。如果离子源排气和低真空泵
排气软管未正确连接到实验室通风系统，请勿运行质谱仪。定期检查排气管道，
以确保没有泄漏。在系统通风不足的情况下使用质谱仪可能会危害健康，或导致
严重人身伤害。

警告! 电离辐射危害、生物危害或有毒化学品危害。如果不了解与离子源一起
使用的有毒或有害材料的妥善利用、防护和疏散方面的知识且未接受相关培
训，切勿使用离子源。

警告! 刺伤危险、电离辐射危害、生物危害或有毒化学品危害。如果离子源窗口
有裂痕或破损，请停止使用离子源，并与 SCIEX 现场服务人员 (FSE) 联系。设
备中引入的任何有毒或有害材料均会存在于离子源排气输出中。设备产生的废气
应从室内排出。请按照既定实验室安全程序处置锐器。

物理注意事项

警告! 升降危险。使用机械升降装置来抬升和移动质谱仪。请遵照既定安全升降操作规
程。我们推荐使用专业的移动服务。关于系统组件的重量，请参阅文档：《场地规划
指南》。

环境注意事项
安排合格的人员安装主电源、加热、通风和上下水管线及固定装置。确保所有的安装均符合当
地规章和生物危害法规。有关该系统所需环境条件的信息，请参阅文档：《场地规划指南》。

设置系统时可以在设备周围预留接入空间。

危险! 爆炸危险。请勿在含有爆炸性气体的环境中运行该系统。该系统不适合在易爆环
境中运行。

操作注意事项和限制
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警告! 生物危害。使用生物危害性物质，一定要遵守危害评估、管控和处理方面的当地
法规。本系统或其任何部分不得作为生物屏障使用。

警告! 环境危害。遵照既定程序处置生物危害性、有毒、放射性和电子废弃物。客
户负责按照当地法律和法规处置有害物质，包括化学品、废油和电气部件。

小心: 潜在的质量偏移。保持稳定的环境温度。如果温度变化超过 2 °C/小时，分辨率和质量校
准可能会受到影响。

电磁环境
电磁兼容性

基本电磁环境：具有直接从公共电网低压供电特征的地点所存在的环境。

性能标准 A（标准 A）：设备按预期运行，在测试期间或之后性能未退化，功能未损失。

性能标准 B（标准 B）：测试期间，设备可能发生（一项或多项）功能损失，但在测试后按预
期运行，性能出现部分退化，功能自动恢复。

性能标准 C（标准 C）：测试期间，设备可能发生（一项或多项）功能损失，但在测试后按预
期运动，性能出现部分退化，功能可由操作员恢复。

本设备拟用于基本电磁环境。

在电磁抗扰情形下的预期性能损失总离子计数 (TIC) 变化小于 20%。

确保可为设备维持可兼容的电磁环境，使该设备按预期运行。如果电源线具有较高电气噪声，
则安装电涌保护器。

电磁干扰

第 1 组设备：此类设备分类为工业、科学和医疗 (ISM) 设备，其内部运行可能使用射频能量。

A 类设备：适用于除住宅及直接与为住宅供电所用低压电源网络相连的所有设施的设备。[摘
自 CISPR 11:2009, 5.3] A 类设备应遵守 A 类限制。

小心: 潜在的无线电干扰。本设备不适用于居住环境，可能无法在此类环境中提供足够的无线
电接收保护。

根据 FCC（美国联邦通信委员会）合规规则第 15 部分的规定，本设备已经进行了测试，证明
符合 A 类数字设备的限制。

这些限制旨在提供合理的保护，防止本设备在商业环境中运行时受到有害干扰。本设备会产
生、使用并可能辐射无线频率能量，如果未按照操作手册要求安装和使用，可能会对无线通信
造成有害干扰。

在住宅区使用本设备可能会造成有害干扰，在这种情况下，消除此类干扰的费用需自行承担。
未得到制造商明确批准的变更或修改可能会使您操作本设备的权限失效。

操作注意事项和限制
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拆除和处置

警告! 环境危害。遵照既定程序处置生物危害性、有毒、放射性和电子废弃物。客
户负责按照当地法律和法规处置有害物质，包括化学品、废油和电气部件。

拆除前，请按当地法规对整套系统进行去污处理。

当弃用系统后，根据国家和当地环境法规条例分离和回收不同材料。请参阅以下章节：质谱仪
存储和处理。

注释: SCIEX 不会接受未完成《净化表》的任何系统回收。请联系现场服务人员获得一份净化
表。

不要将系统组件或部件（包括计算机部件）作为未分类的城市废弃物进行处理。

废弃电子电气设备

遵循当地城市废物法规条例中的合适处理规定，减少废弃电子电气设备 (WEEE) 对环境的影
响。为了安全地处理设备，请联系当地的客户服务部进行免费的仪器上门回收。

合格人员
只有合格的 SCIEX 员工才能安装、检查和维修本设备。安装完系统后，现场服务人员 (FSE)
会使用 Customer Familiarization Checklist（客户熟悉系统检查清单）指导客户熟悉系统操
作、清洁和基本维护。如果系统曾由非 SCIEX 授权人员维修，则 SCIEX 可能无法对系统损坏
进行保修范围内的承保。

只能由制造商认定的合格人员维护设备。可在安装过程中使实验室指定人员熟悉合格维护人员
(QMP) 程序。QMP 是对维护实验室设备相关的电气和化学风险有相应认识的人员。

实验室条件

安全环境条件

系统设计为可在以下条件下安全操作：

• 室内

• 海拔高度：最高 2,000 m（6,560 英尺）

• 环境温度：5 °C (41 °F) 到 40 °C (104 °F)

• 相对湿度：20% 至 80%，无凝结

• 主电源电压波动：标称电压的 ± 10%

• 瞬态过电压：最高可达到过电压类别 II 的级别

• 主电源暂时过电压

• 污染程度 2

操作注意事项和限制
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性能规范

系统设计为在以下条件下符合规范：

• 环境温度为 15 °C 至 26 °C (59 °F 至 78.8 °F)

温度随时间的变化必须保持在 4 °C (7.2 °F) 范围内，温度的变化率为每小时不超过 2 °C
(3.6 °F)。若环境温度波动超出限制，可能会造成谱图质量偏移。

• 相对湿度为 20% 至 80%，无凝结

设备使用和修改

警告! 人身伤害危险。如果产品需要安装、调试或重新安置，请联系 SCIEX 代表。

警告! 触电危险。切勿拆除保护盖。拆除保护盖可能会导致人员受伤或系统故障。
进行例行维护、检查或调整时不需要拆下保护盖。当修理需拆下主盖时，请与
SCIEX 现场服务人员 (FSE) 联系。

警告! 人身伤害危险。只能使用 SCIEX 推荐的部件。使用非 SCIEX 推荐使用的部件或
者将部件用于任何非设计用途，可能会对用户造成伤害，或对系统性能带来不利影响。

警告! 升降危险。使用机械升降装置来抬升和移动质谱仪。请遵照既定安全升降操作规
程。我们推荐使用专业的移动服务。关于系统组件的重量，请参阅文档：《场地规划
指南》。

警告! 压碎危险。移动重物时请穿戴防护鞋。

请在符合质谱仪文档：《场地规划指南》中的建议环境条件的实验室室内使用该系统。

如果系统的使用环境或使用方式不符合制造商规定，那么设备提供的性能和保护可能会受到影
响。

对系统进行未经授权的修改或操作可能会导致人身伤害和设备损坏，且可能会导致保修失效。
在超出建议环境条件时或在经未经授权的修改后运行系统，可能会生成错误数据。有关系统的
维修信息，请联系现场服务人员。

操作注意事项和限制
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操作原理 2
该系统设计用于化学物质的定性和定量分析。

本节包含关于质谱仪的信息。关于离子源概述，请参阅文档：DuoSpray 离子源操作员指南。

关于计算机和软件的信息，请参阅文档：软件的《软件安装指南》。

系统概述
TripleTOF 6600+ 系统包含下列组件：

• TripleTOF 6600+ 质谱仪（配有一个低真空泵）。

• DuoSpray 离子源中所用的 APCI 探针中的电晕放电针应用的流。请参阅文档：
《DuoSpray 离子源操作员指南》。

• 一台 SCIEX 提供的计算机和显示器，带有 Analyst TF 软件，用于进行仪器优化、采集方法
的开发以及数据采集。如需计算机规格和要求，请参阅文档 Analyst TF 软件的《软件安装
指南》。

• 可选的校准物输送系统 (CDS)

硬件概述

图 2-1 和 图 2-2 显示质谱仪组件和连接。

操作原理
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图 2-1 正面和右侧视图

项目 描述 欲了解更多信息……

1 可选的校正品输送系统 请参阅 CDS Operator Guide。

2 DuoSpray 离子源 请参阅 DuoSpray Ion Source for
TripleTOF Systems Operator
Guide。

3 注射泵 请参阅调整集成注射泵位置。

4 质谱仪状态 LED 灯 请参阅面板符号。

5 通信舱壁 联系 SCIEX 现场服务工程师
(FSE)。

操作原理
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项目 描述 欲了解更多信息……

6 注射泵的串行 (RS-232) 电缆连接 请联系现场服务工程师。

7 USB-GPIB 卡的 USB 电缆连接 请联系现场服务工程师。

8 模拟数字转换器卡的 InfiniBand 电
缆连接

请联系现场服务工程师。

图 2-2 左侧视图

操作原理
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项目 描述 欲了解更多信息……

1 气体和真空舱壁 请联系现场服务工程师。

2 低真空泵连接点 请联系现场服务工程师。

3 校正品控制连接 请参阅 CDS Operator Guide。

4 辅助 IO 连接。可选液相色谱系统启
动信号会连接到此端口。

请联系现场服务工程师。

5 外部控制连接。此端口旨在供将来
使用。

请联系现场服务工程师。

6 离子源连接。一些离子源会连接到
此端口。

请联系现场服务工程师。

7 交流配电屏 请联系现场服务工程师。

8 仪器电源开关 请参阅启动系统。

9 覆盖电路断路器 请参阅启动系统。使用电源开关而
不是电路断路器关闭系统。

10 电源连接点 请参阅启动系统。

11 Curtain Gas（氮气）供应连接 请联系现场服务工程师。

12 气体 1 和气体 2（零）供应连接 请联系现场服务工程师。

13 离子源废气（零空气或氮气）供应
连接

请联系现场服务工程师。

14 CAD 气体（氮气）供应连接 请联系现场服务工程师。

15 离子源排废连接 请联系现场服务工程师。

16 未使用 N/A。

17 未使用 N/A。

面板符号

下表介绍了质谱仪状态 LED。

表 2-1 面板符号

LED 颜色 名称 描述

绿色 电源 当系统启动时 LED 灯亮起。

绿色 真空 达到运行真空水平时 LED 灯亮起。真空
度不正确时 LED 灯闪烁（抽气和排气过
程中）。

操作原理
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表 2-1 面板符号 (续)

LED 颜色 名称 描述

绿色 准备就绪 当系统处于就绪状态时，LED 灯亮起。
系统必须处于就绪状态才能运行。

蓝色 扫描 当系统采集数据时，LED 灯闪烁。

红色 故障 当系统遭遇系统故障时，LED 灯亮起。

绿色 注射泵状态 当注射泵工作时，LED 灯亮起。

在系统开启后，所有 LED 灯均亮起。电源 LED 灯保持亮起状态。其他 LED 灯闪烁两秒钟，
然后关闭。真空 LED 灯开始闪烁。在达到运行真空度后，该 LED 灯保持常亮。

工作原理
质谱可测量离子质荷比，以鉴定未知化合物，量化已知化合物，以及提供关于分子的结构和化
学特性的信息。

TripleTOF 6600+ 系统具有一系列根据其质荷比 (m/z) 选择或发射离子的四极过滤器。本系列
的第一个四极杆是 QJet 离子导向器，它位于孔板和 Q0 区域之间。QJet 离子导向器不过滤离
子，而是在离子进入 Q0 区域之前对其进行聚集。通过对由宽孔口产生的较大离子流进行预聚
焦，QJet 离子导向器增加了系统灵敏度，提高了信噪比。在 Q0 区域，离子在进入 Q1 四极杆
之前进一步聚集。

Q1 四极杆可在离子进入 Q2 碰撞池之前对其进行排序。Q1 四极杆有两种运行模式：

• 让指定 m/z 这是一次 TOF MS 扫描。所有离子都使用系统进行分析。

• 让具有指定 m/zm/z 比的某个离子通过 Q2 碰撞池。这是一次 TOF MS/MS 扫描。仅分析选
定的离子。

在 Q2 碰撞池，通过碰撞，气体分子到达某点，分子键断裂，产生产物离子，离子的内部能量
增加。该技术允许用户设计测量产物离子 m/z

通过 Q2 碰撞池后，离子进入 TOF 区，以进行附加质量分析。它们在不同时间到达检测器，
具体时间视其 m/z 在检测器中，离子产生电流，转换成电压脉冲。这些电压脉冲会进行计数，
脉冲数与进入检测器的离子数量成正比。质谱仪可将电压脉冲转换为一种信号，然后将该信息
与每种离子到达检测器的时间建立关联。该信号表示离子强度，到达检测器的时间表示特定的
m/z 质谱仪以质谱的形式显示该数据。

数据处理

Analyst TF 软件需要一台运行 Windows 7、64 位或 Windows 10、64 位操作系统的计算机。
计算机及相关系统与系统控制器和相关固件一起控制系统和数据采集。在系统运行期间，所采

操作原理
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集的数据会被发送至 Analyst TF 软件，此软件可通过完整质谱、离子色谱或离子质谱或总离
子流随时间变化曲线的形式显示这些数据。

操作原理
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操作说明 3
警告! 人身伤害危险。使用系统时，按照文件中的说明进行操作。如果未按 SCIEX 要
求的方式使用设备，则该设备提供的防护可能无法发挥有效作用。

启动系统

警告! 触电危险。确保在紧急情况下可从主电源插座断开。不要挡住主电源插
座。

警告! 升降危险。未事先咨询现场服务人员 (FSE) 的话，不要移动系统。有人身
伤害或系统损坏风险。如果必须移动系统，请联系现场服务人员 (FSE)。

注释: 操作仪器前，请阅读以下章节中的安全信息：操作注意事项和限制。

前提条件

• 满足《场地规划指南》中规定的场地要求。《场地规划指南》包括有关主电源和连接件、
压缩空气、氮气、低真空泵、通风、排气和场地清理要求的信息。如果需要，请联系
SCIEX 索取一份 《场地规划指南》。关于联系信息，请访问 sciex.com/contact-us。

• 离子源废气、压缩空气和氮气与质谱仪相连。

• 4 L 离子源废气排放瓶已连接到质谱仪背面的废气废物连接装置和实验室通风系统上。

• 离子源排气软管牢牢地夹在质谱仪、离子源废气排放瓶和通风连接件上。

• 仪器电源开关已关闭，主电源电缆已插入质谱仪。

• 质谱仪和低真空泵主电源电缆已连接到 200 VAC 至 240 VAC 主电源。

• 以太网电缆同时与质谱仪和计算机相连。

1. 打开低真空泵。

2. 从正面观察时，请取下质谱仪左侧的断路器开关盖，然后打开断路器。请参阅图 2-2。

3. 更换断路器开关盖，然后用手拧紧用于固定此盖的螺钉。

4. 打开仪器电源开关。请参阅图 2-2。

5. 打开计算机。

6. 打开控制软件。
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关闭系统
某些程序要求关闭系统。其他程序还要求对系统进行排气。遵循下列步骤关闭系统并对系统进
行排气（如果需要）。

注释: 如果必须断开气体管线，则断开前释放气体管路内的压力。

提示! 如果质谱仪长期不使用，应使其保持待机状态，并且将离子源放置在适当位置。如果质
谱仪必须关闭，请按以下说明操作。

1. 完成或停止任何正在进行的扫描。

小心: 潜在的系统损坏。关闭系统前，先关闭样本流。

2. 关闭流向系统的样本流。

3. 在 Analyst TF 软件中，如果硬件配置文件处于活动状态，则停用此文件。

4. 关闭此软件。

5. 关闭仪器左侧的电源开关。请参阅硬件概述。

6. （如果需要）遵循下列步骤来对系统进行排气：

注释: 安装离子源实现正常排气。

a. 关闭低真空泵。

b. 等待系统完成通风。此过程需要 15 分钟到 25 分钟。

7. 取下质谱仪左侧的断路器开关盖，然后关闭断路器。请参阅图 2-2。

8. 安装断路器开关盖，然后用手拧紧用于固定此盖的螺钉。

9. （如果对系统进行排气）从主电源插座上断开低真空泵主电源电缆。

调整集成注射泵位置

警告! 刺伤危险。注射器要轻拿轻放。注射器的尖端特别锋利。

警告! 刺伤危险。确保注射器在注射泵内正确就位，并适当调节注射泵的自动停
止设置，以免损坏或打破玻璃注射器。如果注射器破裂，遵循既定安全程序处置
锐器。

关于注射泵在质谱仪上的位置，请参阅图：图 2-1。

1. 按下注射泵右侧的 Release 按钮以降低基部，然后插入注射器。
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图 3-1 降低注射器

项目 描述

1 注射器柱塞

2 释放按钮。按下此按钮可升高或降低基部。

2. 请确保注射器末端与基部平齐，并且注射器的轴安置在保险装置处。

3. 调整标杆，以便其在注射器柱塞撞击玻璃注射器底部之前触发注射器自动停止。
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图 3-2 注射器自动停止

项目 描述

1 注射器自动停止。在标杆触发注射器自动停止之后，注射泵停止。

2 标杆。调整高度，以防止在样本输注过程中注射器柱塞撞击注射器。

3 标杆锁紧螺钉。调整标杆高度之后，拧紧螺钉。

4. 转动注射泵螺钉以固定注射器。
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图 3-3 注射泵螺钉

5. 确保质谱仪和集成注射泵已在软件中激活。

6. 在 Analyst TF 软件中的导航栏上，双击 Manual Tuning。

7. 单击 Start Syringe。

8. 若要停止注射泵，请单击 Stop Syringe。

重置注射泵
如果 Analyst TF 软件停止与注射泵进行通信，则重置注射泵。

使用回形针或类似工具按下图 3-4 中所示的重置按钮。
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图 3-4 重置按钮
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操作说明 — 样品工作流程 4
表 4-1 仪器设置

步骤 目的 信息来源.... 具体事项

1 创建硬件配置文件。 创建硬件配置文件 每一个硬件配置文件
必须包括一台质谱仪
和其他设备，如 LC
系统。创建采集方法
时，只能使用当前硬
件配置文件中所包含
的外围设备。

2 创建项目以存储数据。 创建项目和子项目 使用项目和子项目有
助于数据管理，而且
便于比较结果。

3 优化质谱仪。 优化质谱仪 此过程旨在优化分辨
率和质谱仪参数，并
校正质谱仪以达到系
统的最佳灵敏度和性
能。

表 4-2 样本采集工作流程

步骤 目的 信息来源.... 具体事项

1 创建项目以存储数据。 创建项目和子项目 开始实验前，要先决
定将实验相关文件保
存在何处。使用项目
和子项目可改善数据
管理，而且便于比较
结果。

2 创建采集方法。 操作说明－采集方法 要分析样本，请为质
谱仪和任何 LC 设备
创建一个采集方法。
采集方法指明了要使
用哪些外围设备、何
时使用这些设备采集
数据以及相关参数。

3 创建并提交批次。 添加样本集和样本至批次和提
交样品或样品集

创建采集方法后，通
过创建采集批次并提
交批次至采集队列来
运行样本。
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表 4-2 样本采集工作流程 (续)

步骤 目的 信息来源.... 具体事项

4 运行样本以采集数据。 采集数据 运行样本涉及管理采
集队列以及监测仪器
和设备状态。要提交
样本并采集数据，请
使用 Queue
Manager。Queue
Manager 可显示队
列、批次和样本状
态，有助于管理队列
中的样本和批次。

5 在 Explore 模式下分析数
据。

—或—

操作说明 — 分析和浏览数据 在 Explore 模式下，
可使用多种工具来查
看和处理所采集的数
据。可自定义图形的
峰标签和图注，显示
等值线图，以及在谱
库中保存质谱。

6 使用配套软件分析数据并
打印报告。

MultiQuant 软件/PeakView 软
件

使用 MultiQuant 软件
或 PeakView 软件分
析数据。详情请参阅
软件随附的文档。

表 4-3 熟练用户工作流程

步骤 目的 信息来源....

1 对仪器进行质量数校准。 质量数校准教程位于
• 在 Windows 7 操作系统上：单击 Start > All

Program > SCIEX > Analyst TF > Software
Guides.

• 在 Windows 10 操作系统上，单击 Start > SCIEX
Analyst TF > Analyst TF Documentation,，然后
双击 Software Guides 文件夹。

2 优化质谱仪。 手动优化教程位于
• 在 Windows 7 操作系统上：单击 Start > All

Program > SCIEX > Analyst TF > Software
Guides.

• 在 Windows 10 操作系统上，单击 Start > SCIEX
Analyst TF > Analyst TF Documentation,，然后
双击 Software Guides 文件夹。
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操作说明－硬件配置文件和项目 5
硬件配置文件
借助硬件配置文件，软件可获知质谱仪和设备的配置情况以及它们与计算机的连接方式。可以
配置多个硬件配置文件，但任何时候只有一个配置文件处于激活状态。

在 Hardware Configuration Editor 中创建硬件配置文件时，必须对外围设备进行配置，使软件
能够与其通信。配置外围设备需要完成两个程序：

• 建立物理连接。有关为建立物理连接的设置信息，请参阅文档：《外围设备设置指南》。

• 配置软件以便与外围设备通信。关于受支持设备的列表，请参阅文档：Analyst TF 软件的
《软件安装指南》。

软件安装完成后，每台外围设备所需的驱动程序也安装完成。将外围设备与计算机物理连接
后，就可以配置相应的配置信息。

每一个硬件配置文件必须包括一台质谱仪。在创建采集方法之前，确保该方法使用的所有设备
均包含在硬件配置文件中（包括注射泵）。当前硬件配置文件所配置的以及在 Add/Remove
Device Method 对话框中选定的设备在 Acquisition method 窗格中以图标显示。只有当前激活
的硬件配置文件中已包含的外围设备才可在采集方法中使用。

创建硬件配置文件

用户可以创建多个硬件配置文件，但任何时候只有一个配置文件处于激活状态。

1. 在导航栏上的 Configure 下，双击 Hardware Configuration。

操作说明－硬件配置文件和项目
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图 5-1 Hardware Configuration Editor 对话框

2. 单击 New Profile。
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图 5-2 Create New Hardware Profile 对话框

3. 在 Profile Name 字段中键入一个名称。

4. 单击 Add Device。
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图 5-3 Available Devices 对话框

在 Available Devices 对话框中，Mass Spectrometer 是 Device Type 字段中的预设值。

5. 在 Devices 列表中，选择合适的质谱仪，然后单击 OK。

6. 在 Create New Hardware Profile 对话框中，单击 Setup Device。

7. （可选）若要为质谱仪配置集成式注射泵，请在 Configuration 选项卡上，选中 Use
integrated syringe pump 复选框。
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图 5-4 配置校准物输送系统 (CDS) 和注射泵的 Configuration 选项卡

8. （可选）若要为质谱仪配置校准物输送系统 (CDS)，在 Configuration 选项卡上，选择
Use calibrant delivery system (CDS)。

9. （可选）根据需要选择 Configuration 和 Communication 选项卡上的其他功能。

10. 单击 OK。

11. 在 Create New Hardware Profile 对话框中，单击 Add Device，然后添加并设置与质谱仪
共同使用的每个设备。请参阅以下章节：添加设备至硬件配置文件。

12. 在 Create New Hardware Profile 对话框中单击 OK。

13. 在 Hardware Configuration Editor 中单击要激活的硬件配置文件。

14. 单击 Activate Profile。
复选标记变为绿色。如果显示的是红色 ×，则硬件配置文件激活出现问题。
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提示! 激活另一硬件配置文件之前无需停用当前硬件配置文件。单击硬件配置文件，然后
单击 Activate Profile。当前的活动配置文件自动停用。

15. 单击 Close。

添加设备至硬件配置文件

必须对设备进行配置，从而使软件可以与设备进行通讯。当软件安装完成时，每个设备所需的
驱动也安装完成。设备必须先通过物理方式连接至计算机，然后才能进行配置。有关更多信
息，请参阅文档：《外围设备设置指南》。

1. 打开 Hardware Configuration Editor。

2. 在 Hardware Profiles 列表中，停用硬件配置文件。

3. 单击 Edit Profile。

4. 单击 Add Device。
Available Devices 对话框打开。

5. 在 Device Type 列表中选择设备，然后单击 OK。

图 5-5 Available Devices 对话框

6. 单击 OK。

7. 从 Devices 列表中选择设备，然后单击 OK。

8. 单击 Setup Device。
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此时会打开包含设备配置值的对话框。

9. （可选）在 Communication 选项卡的 Alias 字段中，键入一个名称或其他设备标识符。

注释: 对于使用串行通讯的设备，确保选择的串行端口和与设备物理连接的串行端口相匹
配。

注释: Alias 字段也可以指的是 Name 框，而且可能会在 Alias 下的另一个选项卡上找
到。

• 如果设备使用了一个 Serial Port 作为通讯接口，那么在 COM Port Number 列表中，
选择与设备相连的 COM 端口。

• 如果设备使用了 Ethernet 作为通讯接口，那么键入由管理员分配给设备的 IP
Address 或使用地址的相应 Host Name。

• 如果设备使用 GPIB Board 作为通讯接口，那么不要改变 GPIB 板的设置。

设备的其他预设值很可能是合适的。不要更改它们。欲获知更多关于 Configuration 和
Communication 选项卡的信息，请参阅帮助。

10. 若要恢复设备预设值，在 Communication 选项卡上，单击 Set Defaults。

11. 若要保存配置，单击 OK。

12. 对每个设备重复步骤 4 至步骤 11。

13. 在 Create New Hardware Profile 对话框中单击 OK。

14. 要激活硬件配置文件，请执行此操作：

a. 在 Hardware Configuration Editor 中，单击硬件配置文件。

b. 单击 Activate Profile。

复选标记变为绿色。如果显示的是红色 ×，则硬件配置文件激活出现问题。有关更多信
息，请参阅以下章节：硬件配置文件激活问题排解。

提示! 激活另一硬件配置文件之前无需停用当前硬件配置文件。单击一个未激活的硬件配
置文件，然后单击 Activate Profile。另一个配置文件自动失效。

15. 单击 Close。

硬件配置文件激活问题排解

如果激活一个硬件配置文件时失败，则会出现一个对话框，显示配置文件中未能激活的设备。
设备可能因通信错误而无法激活。

1. 阅读产生的错误消息。根据错误消息，可能存在设备问题或通讯设置方式问题。

2. 确保设备已连接到主电源并接通。

3. 确保分配给设备的串行通讯端口（COM 端口）正确。

4. 确保设备的通讯设置（如拨码开关设置 (DIP)）设置正确并且与 Communication 选项卡上
的设置相匹配。
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5. 关闭设备。

6. 等待 10 秒钟。

7. 打开设备。
在尝试再一次激活硬件配置文件之前，等待所有设备启动完毕。一些设备可能需要 30 秒
或更长的时间完成启动。

8. 激活硬件配置文件。

9. 如果问题仍然存在，删除失败配置文件，并创建一个新的配置文件。

10. 如果问题仍然继续存在，请访问 sciex.com/request-support。

项目和子项目
开始实验前，要先决定将实验相关文件保存在何处。使用每个实验的项目和子项目来更好地管
理数据和比较结果。比如，使用子项目来保存特定日期的结果。

创建项目和子项目

要使用一个项目内的子项目结构，请在创建项目后创建子项目结构。

1. 单击 Tools > Project > Create Project.
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图 5-6 Create New Project/Subproject 对话框

注释: 只有在项目最初创建了子项目的情况下，才能为该项目创建新的子项目。

2. 在 Project name 字段键入项目名称。

3. （可选）要使用子项目，请执行以下步骤：

a. 请选择所需的文件夹，然后用箭头按钮将它们移动到 Subproject folders 列表。

b. 在 Subproject name 字段中，为第一个子项目键入一个名称，或者使用现有日期。

4. （可选）若想要所有新项目使用此项目和子项目文件夹组织，请选择 Set configuration
as default for new projects 复选框。
所有项目在创建时均会使用此文件夹配置。

5. 单击 OK。

创建子项目

子项目只能在一个存在子项目结构的项目中创建。
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1. 在 Project 工具栏上，从 Project 列表中选择项目。

2. 单击 Tools > Project > Create Subproject。

3. 在 Subproject name 框中，为子项目键入一个名称，或者使用目前的日期。

4. 单击 OK。

复制子项目

可从既有子项目的另一项目中复制子项目。如果复制的子项目中所包含的文件夹也存在于目标
项目文件夹中，那么软件会使用项目层级文件夹。

1. 单击 Tools > Project > Copy Subproject.
Copy Subproject 对话框随即打开。

2. 单击 Browse，浏览子项目来源。

3. 单击 OK。

4. 从 Source Subproject 列表中选择子项目。

5. 单击 Browse，浏览子项目目标位置。

6. 在 Target Subproject 字段中键入名称。

7. 单击 OK。

8. 执行以下任一操作：

• 要将所有文件夹和文件从 Subproject Source 复制到 Subproject Destination，请选
中 Copy Contents 复选框。

• 要仅将结构相同的文件夹复制到 Subproject Destination，请确保已取消选中 Copy
Contents 复选框。

9. 单击 Copy。

在项目和子项目之间变更

在软件的工具栏的项目列表中，单击所需的项目或子项目。

图 5-7 项目列表

本图中的项目列表显示了 API Instrument、Default 和 Example 文件夹。
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已安装的项目文件夹

随软件一起安装了三个项目文件夹：API Instrument、Default 和 Example。

API Instrument 文件夹

API Instrument 文件夹具有唯一性，且对于质谱仪的正常运行非常重要。API Instrument 文件
夹包含调谐和校准质谱仪所需的相关信息。这些信息包括：

• 参数设置文件

• 参考文件

• 包含校准和分辨率信息的仪器数据文件

• 在自动调谐期间使用的采集方法

API Instrument 文件夹还包含有关手动调谐运行的数据文件，执行该手动调谐运行时使用的是
Start 按钮而非 Acquire 按钮。这些数据文件会自动保存到
API Instrument\Tuning Cache 文件夹中，并以它们的创建日期和时间命名。系统会定

期自动清理 Tuning Cache 文件夹。

Default 文件夹

Default 文件夹包含新项目中存在的所有文件夹，并作为新项目的模板使用。

Example 文件夹

Example 文件夹包含样本方法和数据文件。用户可以利用实例数据文件来练习使用 Explore
式。

备份 API Instrument 文件夹

定期并在执行日常维护之后备份 API Instrument 文件夹。

复制 API Instrument 文件夹，粘贴至不同位置，最好是在另一台计算机上，然后重命名该

文件夹。如果有多台质谱仪，则在命名该文件夹时使用日期和质谱仪参考。例如，API
Instrument_QT6500plus3_010121

恢复 API Instrument 文件夹

定期并在执行日常维护之后备份 API Instrument 文件夹。

1. 重命名当前 API Instrument 文件夹。

2. 复制备份文件夹至 Projects 文件夹。

3. 将备份文件夹更名为 API Instrument。

操作说明－硬件配置文件和项目

TripleTOF 6600+ 系统
40/127

系统用户指南
RUO-IDV-05-8593-ZH-D



操作说明 － 调谐和校准 6
可以在任何时候运行 Verify Performance Only 选项。但是，只有在出现明显的灵敏度分辨力
下降的情况下才进行仪器调谐。欲获知更多关于调谐和校准的信息，请参阅《高级用户指
南》。

对于系统调谐，使用与安装套件一起提供的以下溶液：

对于阳离子模式：

• 若需要优化 TOF MS－产物离子高分辨力或产物离子高灵敏度，请使用调谐溶液。

• 对于 Q1 校准，请使用 PPG POS 溶液。

阴离子模式：

• 若需要优化 TOF MS－产物离子高分辨力或产物离子高灵敏度，请使用牛黄胆酸。

注释: 我们建议在使用牛磺胆酸之后，使用 PPG POS 溶液重复进行通道校准。

• 对于 Q1 校准，请使用 PPG POS 溶液。

提示! 定期进行维护工作，保证质谱仪在最佳情况下运行。

前提条件

• 喷雾稳定，而且使用了正确的调谐溶液。

• 配置了一个打印机。

所需材料

• 存放在与系统一起运送的 Standards Chemical Kit 中的调谐溶液。如果需要，可以从
SCIEX 订购新的试剂盒。

• 气密注射针（推荐 1 mL）

• 红色 PEEK 样本管。

• （可选）注射泵，如果使用的系统没有集成的注射泵。

优化质谱仪
以下程序描述如何验证质谱仪的性能。有关使用其他仪器性能选项的更多信息，请参阅《帮
助》。

1. 在导航栏上的 Tune and Calibrate 下，双击 Manual Tuning。

2. 运行 TOF MS 或产品图标扫描类型，并确认有稳定的 TIC 并且色谱图中存在兴趣峰值。
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3. 在导航栏上的 Tune and Calibrate 下，双击 Instrument Optimization。
Instrument Optimization 对话框打开。

4. 选择一种调谐溶液。确保调整溶液与参考表一致。

5. Verify Performance Only 复选框已预选。单击 Next。
此示例中保留此选项的选中状态。如果报告显示仪器需要调整，则再次运行仪器优化，然
后选择一个或多个扫描模式进行优化。

6. 确保离子源和注射器参数适用。

注释: 用户也可使用 CDS 注射溶液。确保调整溶液与参考表中的配置一致。设置适当的流
速，然后单击 CDS Inject。

注释: 确保在所选参考表的参考表编辑器中选择正确的校准物阀位。最多可以从四个不同
的位置（A 至 D）选择 CDS。

7. 单击 GO。
Verifying or Adjusting Performance 屏幕随即打开。完成此过程之后，Results
Summary 打开。欲了解更多信息，请参阅《帮助》。

Verifying or Adjusting Performance 对话框
左上角显示的是正在进行调谐的仪器部分。

当前谱图显示了当前扫描、通过软件选择的最佳扫描或在交互模式下查看软件结果时采用当前
参数值的扫描的谱图。

右上图中的 Instrument Optimization Decision Plots（仪器优化决策图）动态显示了当前正在
优化参数的强度-电压曲线。

Results Summary
Results Summary 是 Instrument Optimization 向导所作仪器设置更改的记录。
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图 6-1 Results Summary：TripleTOF 6600 系统

Results Summary 自动保存在以下路径：
<drive>:\Analyst Data\Projects\API Instrument\Data\Instrument
Optimization\yyyy-mm-dd\results.pdf，其中 yyyy-mm-dd 是报告的创建日期。用户

可以打印 Results Summary，或打开之前保存的 Results Summary。
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操作说明－采集方法 7
采集方法包含实验和周期。使用 Acquisition Method Editor 为质谱仪以及当前硬件配置文件中
的任何设备创建周期和实验序列。

采集方法由用于质谱仪和液相色谱 (LC) 设备的方法组成。使用 Method Wizard 用户可以轻松
创建采集方法。

也可使用 Acquisition Method Editor 创建采集方法，以及添加仪器和设备的周期和实验序列。

使用在 Method Wizard 和 Acquisition Method Editor 中均可用的 SWATH 采集功能创建
SWATH 采集方法。此外，还可使用 Method Wizard 或 Acquisition Method Editor 来创建窗口
宽度可变的 SWATH 方法。 有关更多信息，请参阅《高级用户指南》、Analyst TF 帮助和
Method Wizard 帮助。

我们建议，只有精通方法开发的用户才可创建或修改采集和定量方法。有关角色和安全性的更
多信息，请参阅文档：《实验室主管指南》。

使用采集方法编辑器创建采集方法

提示! 如果用户正在从现有的文件创建一个新采集方法文件，那么可能使用采集方法中的部分
或全部的外围设备方法。

只有在激活的硬件配置文件中配置的设备才会出现在 Acquisition method 窗格中。此外，添加
到硬件配置文件中的任何设备均必须添加到现有的采集方法中。有关设备的更多信息，请参阅
文档：《外围设备设置指南》。

1. 确保含有质谱仪和外围设备的硬件配置文件处于激活状态。

2. 在导航栏上的 Acquire 下，双击 Build Acquisition Method。

3. 在 Synchronization ModeAcquisition Method Properties 选项卡上选择 。

4. （可选）选中 Auto-Equilibration 复选框，然后键入所需的平衡时间（单位为分钟）。

5. 在 Acquisition Method 窗格中，单击 Mass Spec 图标。

6. 在 MS 选项卡中，选择 Scan type。

7. 根据需要在其他字段中键入值。

8. 在 Advanced MS 选项卡上，根据需要在字段中键入值。

9. 在 MS 选项卡中，单击 Edit Parameters。

10. 在 Source/Gas 选项卡上，根据需要在字段中键入值。

11. 在 Compound 选项卡上，根据需要在字段中指定值。

12. 单击 OK。

13. 单击设备图标，然后设置设备的参数。
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14. 添加任何额外的时段和实验。请参阅以下章节：添加实验和添加时段。

15. 单击 File > Save.

添加实验

1. 在采集方法窗格中，右键单击要添加实验的时段，然后单击 Add experiment。

图 7-1 添加实验

实验添加到此时段内最后一个实验之后。

注释: 实验无法插到实验、IDA 标准或时段之间。用户只能在时段末尾时添加实验。

2. 在 MS 选项卡上，选择合适的参数。

添加时段

在 Acquisition method 窗格中，右键单击 Mass Spec 图标，然后单击 Add period。
在创建的最后一个时段下方即会添加一个时段。

注释: 用户在信息关联采集实验中不能使用多个时段。

复制实验至时段中

1. 打开一个多时段方法。

2. 在 Acquisition method 窗格中，按住 Ctrl，然后将实验拖拉至时段中。
此实验复制到此时段内最后一个实验之后。

复制时段内的实验

如果大部分或所有的参数都相同，使用此程序添加相同或相似的实验到一个时段。

右键单击该实验，然后单击 Copy this experiment。
该实验副本会添加至所创建的最后一个实验的下面。
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使用 Method Wizard 创建 Acquisition Method
采集方法可以保存在现有项目中。

提示! 要将 Method Wizard 模板方法复制到项目文件夹的 Acquisition Methods 文件夹中，
在 Create New Project or Subproject 对话框中选中 Copy method templates 复选框。 要
打开此对话框，单击 Tools > Project > Create Project 或 Create Subproject。

1. 确保含有质谱仪和外围设备的硬件配置文件处于激活状态。

2. 在软件工具栏上，确保选中适当的项目。

3. 在导航栏上，在 Acquire 模式下，双击 Method Wizard。
Method Wizard 打开。

提示! 将光标移到该界面，查看工具提示和程序。

4. 从 Choose MS Method 列表中选择 TOF MS (+)。

5. 从 Choose LC Method 列表中选择为硬件配置文件创建的液相色谱方法。

6. 键入方法的名称，然后按 Enter。

7. 单击 Next。

8. 在 Ion Source Parameters 选项卡上，验证这些值，如有必要对其进行编辑，然后单击
Next。

9. 在 TOF MS 选项卡上，验证这些值，如有必要对其进行编辑，然后单击 Finish。

提示! 如果需要，用户可以使用 Acquisition Method Editor 进一步编辑采集方法。 在
Acquire 模式下，单击 File > Open，然后打开使用 Method Wizard 所创建的方法。

下一步：现在即可使用新创建的采集方法获取数据以进行初步分析。

扫描技术
该系统是一种用途广泛的、可靠的系统，用于对样本液流执行液相色谱-质谱分析，以便识
别、量化和检测化合物。

该系统采用以下质谱技术对样本进行分析：

• 单一质谱法 (MS) 的两种模式：

• 基于四极的单一质谱分析（仅适用于 Q1 校正）

• 基于飞行时间的单一质谱分析

• 串联质谱法 (MS/MS) 的两种模式：

• 产物离子质谱分析

• 前体离子质谱分析
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单一质谱
单一质谱 (MS) 用来分析带电分子以获得分子量和检测到的离子总量。 由质谱检测到的个别离
子可以指示目标分析物的存在。

基于四极杆的单一质谱分析

在基于四极杆的单一质谱分析 (Q1 MS) 扫描中，系统将作为一个传统的四极杆质谱仪运行。
在这种模式下，系统使用仪器的第一个四极杆(Q1)部分生成单一质谱信息。

飞行时间单一质谱分析

在飞行时间单一质谱 (TOF MS) 扫描中，通过使离子进入飞行管并在检测器处记录它们的精确
到达时间，系统可以生成质谱信息。 质荷比较大的离子需要较长的时间才能穿过飞行管。

串联质谱
MS/MS 技术非常适用于混合物分析，因为在假定产物离子具有唯一 m/z 比条件下，混合物中
每个组分都能可以获得特征性的产物离子质谱，而且不受其他组分的感染。

当样品洗脱时，使用 MS/MS 通过监测特定前体离子/产物离子来进行目标分析。 与只根据质
荷比进行区分的单 MS 相比，这种分析类型更具专一性。

产物离子质谱分析

在产物离子扫描（Product Ion（产物离子））中，通过选定 Q1 中的特定前体离子窗口、在
Q2（一个碰撞池）中发生碎裂和使离子（碎片离子）进入飞行管以及记录其在检测器处的精
确到达时间，系统即可生成质谱信息。 产物离子可以提供关于原始（前体）离子的分子结构
的信息。

前体离子质谱分析

在前体离子扫描中，系统可检测到生成特定产物离子的前体离子。 仪器利用质量分辨模式中
的 Q1 扫描所关注的质量范围，同时 TOF 部分会记录每种前体离子的产物离子谱图。 Q1 质
谱会显示生成所关注产物离子的所有前体离子。

谱图数据采集相关内容

有关谱图数据采集模式的说明，请参阅表格：表 7-1。

只能从 Q1 和前体离子扫描类型中获取谱图数据。

表 7-1 谱图数据

模式 描述

轮廓图 预设值为 0.1 Da。轮廓图数据是指由质谱仪产生的数据，并且与以一系列
均匀分布的离散质量值记录的强度相对应。例如，对于质量范围为 100
Da 至 200 Da 且步长为 0.1，仪器以 0.1 Da 自 100 Da 至 200 Da 递增扫
描（例如 100.0，100.1，100.2，100.3 至 200.0）。
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表 7-1 谱图数据 (续)

模式 描述

跳峰 预设值为 1.0 Da。跳峰是操作质谱仪的一种模式，在这种模式中，质谱仪
进行大步长扫描（约 1 Da）。它具有速度优势（更少的数据步），但会
丢失峰形信息。

MS 参数
工作参数是当前正在使用的一系列质谱仪 (MS) 参数。

该方法会存储化合物参数以及离子源和气体参数。分辨率和检测器参数取决于质谱仪，并存储
为仪器数据。如果使用调谐和校准模式创建方法，则可优化工作参数以获得最佳的仪器性能。
或者，在循环实验的过程中，逐个斜升各参数。

• 离子源和气体参数：这些参数可以根据所使用的离子源发生变化。

• 化合物参数：这些参数主要是由离子路径电压组成。化合物依赖型参数的最佳值因正在分
析的化合物不同而有所变化。

• 分辨率参数：这些参数会影响分辨率和校准。

• 检测器参数：这些参数会影响检测器。多通道板是 TOF 仪器中的检测器，由用于进行离子
检测的四个通道组成。通道总数等于离子强度。此参数可以使用仪器优化模块进行优化。

表中的参数适用于系统随附的离子源。如需关于其他离子源的信息，请参阅随离子源提供的
《操作员指南》。下图显示了参数在离子光学路径中的位置。
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图 7-2 离子光学路径和参数

位置 参数 参数类型 用途 扫描类型

1 IonSpray
Voltage
Floating
(ISVF)

离子源和气
体

离子喷雾电压浮动参数会影响喷雾的稳
定性，从而影响该信号的灵敏度。这是
施加到喷撒样本所使用的针上的电压。

全部

1 Ion Source
Gas 1
(GS1)

离子源和气
体

GS1 参数控制用于 ESI 探针的雾化器
气体。

全部

1 Ion Source
Gas 2
(GS2)

离子源和气
体

GS2 参数控制 ESI 探针的加热器气体
和 APCI 探针的雾化器气体。

全部

1 Temperatur
e (TEM)

离子源和气
体

TEM 参数控制 TurboIonSpray 探针加
热器气体的温度或 APCI 探针的温度。

全部

1 Curtain
Gas (CUR)

离子源和气
体

CUR 参数控制 Curtain Gas 接口的气
体流量。Curtain Gas 接口位于气帘板
和小孔之间。它可以防止离子光学系统
的污染。

全部
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位置 参数 参数类型 用途 扫描类型

1 去簇电压
(DP)

化合物 去簇电压参数会控制孔上的电压，此电
压会控制孔与 QJet 离子导向器。它用
于尽量减少在样本离子进入真空室后仍
残留在其上的溶剂团簇，必要时用于产
生碎片离子。电压越高，传递给离子的
能量越高。如果 DP 参数过高，则可能
会出现不需要的碎裂。

使用预设值，并根据化合物进行优化。

全部

2 CAD 气体 离子源和气
体

CAD 参数控制碰撞池中的 CAD 气体
的压力。碰撞气体有助于在离子穿过碰
撞池时聚集离子；CAD 参数的预设值
为 Fixed 模式。对于串联质谱扫描类
型，CAD 气体有助于使前体离子碎
裂。当前体离子与碰撞气体发生碰撞
时，它们离解形成产物离子。

使用预设值，并根据化合物进行优化。

全部

2 Collision
Energy
(CE)

化合物 碰撞能量参数控制 Q0 区域与 Q2 碰撞
池之间的电势差。它仅用于串联质谱扫
描类型。此参数是前体离子在加速进入
Q2 碰撞池（在此池中，它们与气体分
子碰撞并发生碎裂）时接受的能量大
小。

使用预设值，并根据化合物进行优化。

TOF MS，
TOF
MS/MS

2 Collision
Energy
Spread
(CES)

化合物 当使用碰撞能量散布时，碰撞能量散布
参数连同碰撞能量参数一起确定哪三种
离散碰撞能量会在 产物离子扫描中施
加到前体离子质量。碰撞能量从低值变
为高值。例如，在正离子模式中，碰撞
能量就会从 CE – CES 变为 CE +
CES。通过输入碰撞能量散布值，碰
撞能量散布会自动开启。

使用预设值，并根据化合物进行优化。

TOF
MS/MS
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位置 参数 参数类型 用途 扫描类型

3 Ion
Release
Delay (IRD)

化合物 离子脉冲之前的时长，单位为毫秒。默
认值（11 毫秒）基于 TOF 质量计算得
来，可由操作者进行调整。范围通常为
6 毫秒到 333 毫秒。

如果在 Instrument Optimization 选
项中选中了 Enhanced Ion 选项，则
可使用 Advanced 向导对此参数进行
优化。一般情况下，默认值无需更改。

仅
MS/MS，
增强

3 Ion
Release
Width
(IRW)

化合物 这是离子脉冲的宽度或持续时间（单位
为毫秒），基于离子释放延迟计算得
来。范围通常为 5 至 328 毫秒，默认
值为 10 毫秒。

如果在 Instrument Optimization 选
项中选中了 Enhanced Ion 选项，则
可使用 Advanced 向导对此参数进行
优化。一般情况下，默认值无需更改。

仅
MS/MS，
增强

4 MCP
(CEM)

检测器 CEM 参数控制施加到检测器上的电
压。此电压会影响检测器的响应。

全部

操作说明－采集方法
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操作说明 — 批次 8
小心: 潜在的系统损坏。如果连接到质谱仪的 LC 系统并非由软件控制，则在运行期间不得使
质谱仪处于无人值守的状态。质谱仪进入待机状态后，来自 LC 系统的液流可能会淹没离子
源。

一个批次是指关于待分析样本的信息集合。样本通常分组为不同的集合以简化提交。将样本组
成集合还可以减少必须手动输入的数据量。一个样本集可包含单个样本或多个样本。一个批次
中的所有集合均使用相同的硬件配置文件。不过，一个集合中的样本可以有不同的采集方法。
批次只能从采集计算机提交。

批次包括以下信息：

• 样本信息，如名称、ID 和评注

• 自动进样器支架信息、进样瓶位置和进样体积

• 采集方法

• 处理方法或脚本（可选）

• 定量信息（可选）

• 自定义样本信息（可选）

• 数据集合信息

设置队列选项
软件将逐一处理队列中的样本列表，使用所选的采集方法采集每个样本。所有样本采集完成
后，采集停止，质谱仪在经过 Queue Options 中设置的 Max. Idle Time 后进入 Standby 状
态。在 Standby 状态下，LC 泵停止，部分仪器电压关闭。

用户可以更改从采集最后一个样本到变成 Standby 状态的时间。想了解关于 Queue Options
对话框中其他字段的信息，请参阅文档：《帮助》。

1. 在导航栏上，单击 Configure。

2. 单击 Tools > Settings > Queue Options.

操作说明 — 批次
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图 8-1 Queue Options 对话框

3. 在 Max. Num. Waiting Samples 字段中，将样本数的最大值设置为大于要提交到队列的
样本数。

4. 在 Max. Idle Time 字段中，键入在采集完成后进入 Standby 之前，软件将要等待的时
间。预设值为 60 分钟。

如果使用了气瓶，则需要调整这个时间，以保证气瓶中的气体没有耗尽。

如果使用了液相色谱法，则在运行开始之前，确保在储液器中有足够的溶剂来满足所有样
本主流速运行和最大空闲时间的要求。

5. 选中 Leave Mass Spec on in Standby 复选框使质谱仪在分析完成后继续运行。

这个功能使加热器和气体在设备进入空闲状态后仍能继续运作，从而确保离子源和质谱仪
入口不受污染。

6. 选中 Fail Whole Batch in Case of Missing Vial 复选框，从而当遇到缺失样本瓶的情况
下，整个批次停止进样。

如果未选中这个选项，仅当前样本会进样失败，软件会继续转至下一样本。

7. 选中 Fail Whole Batch if Auto Calibration Fails 复选框，从而当自动校准失败时，这个
批次停止进样。

8. 选中 Keep Calibration Data File 复选框，校准数据文件会保留在样本提交项目中数据文
件夹下的一个子文件夹中。

操作说明 — 批次

系统用户指南
RUO-IDV-05-8593-ZH-D

TripleTOF 6600+ 系统
53/127



9. 选中 Continue Whole Batch if Missing Sync found 复选框后，当遇到同步缺失信号
时，将继续采集整个批次。如果未选中这个复选框，则当遇到这个信号时，当前样本进样
失败且队列不会继续转至下一样本。

添加样本集和样本至批次
一个样本集可包含单个样本或多个样本。

注释: 有关将定量信息添加至批次的更多信息，请参阅文档：《高级用户指南》。

1. 在导航栏上的 Acquire 下，双击 Build Acquisition Batch。

图 8-2 Batch Editor 对话框

2. 在 Sample 选项卡的 Set 列表中，键入一个名称。

3. 单击 Add Set。

4. 单击 Add Samples 来添加样本至一个新的样本集。
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图 8-3 Add Sample 对话框

5. 在 Sample name 部分的 Prefix 字段中，为这个集合中的样本键入一个名称。

6. 若要在样本名称末添加递增编号，选中 Sample number 复选框。

7. 如果已选中 Sample number 复选框，那么在 Number of digits 字段中键入包含在样本
名称中的数字位数。
例如，如果键入了数字 3，那么样本名称将会为“样本名称 001”、“样本名称 002”和“样本
名称 003”。

8. 在 Data file 部分的 Prefix 字段中，为储存样本信息的数据文件键入一个名称。

9. 选中 Set name 复选框可以使用样本集名称作为数据文件的一部分。

10. 选择 Auto Increment 复选框可以使数据文件名称自动递增。

注释: 每一个样本的数据可以储存在同一个或独立的数据文件中。数据文件的名称会有从
1 开始的数字后缀。

11. 在 Sub Folder 字段中键入一个名称。
此文件夹储存于当前项目的 Data 文件夹中。如果 Sub Folder 字段留空，那么数据文件

会储存于 Data 文件夹中，而且不会创建子文件夹。

12. 在 New samples 部分的 Number 字段中，键入要添加的新样本数量。

13. 单击 OK。
样本表中填有样本名称和数据文件名称。

提示! 选中单列标题或一列中多行之后，在右键菜单中可以使用 Fill Down 和 Auto
Increment 选项。
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14. 在 Sample 选项卡的 Acquisition 部分中，从列表内选择一种方法。
根据系统的设置方式，必须输入自动进样器的具体信息。即使在方法中已经设置了进样体
积，用户仍能够通过更改进样容积列中的数值来改变一个或更多样本的进样体积。

注释: 若样本集中的一些样本要采用不同方法，请选中 Use Multiple Methods 复选框。
Acquisition Method 列会显示于 Sample 表中。在这列中选择每个样本的采集方法。

15. 要将进样体积从方法中所列的体积更改为其他值，在 Inj. Volume (µL) 列中键入每种样本
的进样体积。

16. 要设置样本位置，请执行下列操作之一：

• 在批次编辑器中设置样本位置

• 使用 Locations 选项卡选择样品瓶位置（可选）

17. 打开 Submit 选项卡。

注释: 将样本提交至队列之前，可以编辑它们的顺序。要更改样本顺序，请在 Submit 选项
卡上，双击表最左边的任何一个数字（会显示一个非常模糊的框），然后将它们拖动到新
的位置。

18. 如果 Submit Status 部分中包含一条关于批次状态的消息，请执行以下操作之一：

• 如果消息表明该批次已经准备好进行提交，则转到步骤 19。

• 如果该消息提示批次未做好提交准备，请根据消息的指示进行更改。

19. 确认批次信息全部正确后，单击 Submit。
该批次被提交至队列，并且可以在 Queue Manager 中查看。

20. 保存文件。

提交样品或样品集

注释: 如果在样本采集过程中出现异常终止，请再次运行该样本。如果异常终止是由停电引
起，则自动进样器托盘的温度不再保持恒定，因而给样本品质带来问题。

1. 选择样本或样本集。

2. 打开 Batch Editor 中的 Submit 选项卡。

3. 如果 Submit Status 组包含有关批次状态的消息，那么执行下列操作之一：

• 如果消息表明该批次已经准备好进行提交，则转到下一步。

• 如果该消息提示批次未做好提交准备，请根据消息的指示进行更改。

4. 单击 Submit。

设置样品校正
该软件能够在以批次模式采集样品的同时，自动安排和执行外部自动校正。 这可确保在整个
采集过程中保持良好的质量准确性。
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如果未配置 CDS，则使用自动进样器进行校正，用户必须提供校正方法 (*.dam) 和校正样品的
样品瓶位置。

1. 在 Batch Editor（批次编辑器）中，单击 Calibrate（校正）选项卡。

2. 在 Calibrate Every _ Samples 字段中，键入要在校正样品之间采集的样品数量。

3. 在 Calibrant Reference Table（校正品参考表）中，从可用于电流极性的所有校正品参
考表的列表中选择一个表。 确保所选参考表具有正确的 Calibrant Valve Position（校正
品阀门位置）。

4. 设置 CDS Inject Flow Rate（校正品输送系统注射流速）。
提交批次时，将校正样品插入到队列中。 每一组都从校正样品开始。 校正方法命名为
AnalystCal_ 加上采集方法的名称（例如 AnalystCal_TOF.dam）。 如果配置了校正品输
送系统，则软件会自动创建与适用于队列中下一个样品的采集方法相匹配的校正方法。 将
校正数据保存到每个校正样品的独立数据文件中。 如果在 Queue Options（队列选项）对
话框中选择了 Keep Calibration Data File（保存校正数据文件），那么系统会将校正数据
文件连同校正报告一起保存在子文件夹 Cal Data 中，命名为 Cal 加时间戳和校正样品索
引（例如 Cal200906261038341.wiff）。 将校正报告命名为 Cal 加时间戳、校正样品索引
和 report 一词（例如 Cal20130822154447030_report.txt）。 报告显示了峰发现标准、参
数和用于校正的质量。 它会通知用户校正是否成功。 报告还总结了用于校正的参数。

更改样品顺序
将样本提交至 Queue 之前，可以更改它们的顺序。

在 Submit 选项卡上，双击表最左边的任何一个数字（可以看见一个非常模糊的框），然后将
它们拖动到新的位置。

采集数据
开始样本采集时，软件切勿处于调谐和校准模式。此外，如果系统在当天早些时间运行过，而
且还没有设置成待机状态，则会自动开始样本采集。

1. 确保达到柱温箱温度。

2. 确保未按下 Reserve Instrument for Tuning ( ) 图标。

3. 在导航栏上，单击 Acquire。

4. 单击 View > Sample Queue.
Queue Manager 打开，显示出所有提交的样本。

图 8-4 Queue Manager
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项目 描述

1 不应按下 Reserve Instrument for Tuning 图标。

2 队列状态必须为就绪。

3 Queue Server 状态必须为正常。请参阅以下章节：队列状态。

5. 单击 Acquire > Start Sample.

在批次编辑器中设置样本位置
如果在采集方法中使用自动进样器，那么必须在采集批次中定义样本瓶位置。在 Sample 选项
卡或 Locations 选项卡中定义位置。有关创建批次的更多信息，请参阅章节：添加样本集和样
本至批次。

1. 在 Sample 选项卡的 Set 列表中，选择样本集合。

2. 对于样本集中的每份样本，执行以下操作（如适用）：

• 在 Rack Code 列中，选择样本架类型。

• 在 Rack Position 列中，选择自动进样器中的样本架位置。

• 在 Plate Code 列中，选择进样盘类型。

• 在 Plate Position 列中，选择样本架中的进样盘位置。

• 在 Vial Position 列中，键入进样盘或托盘中的样本瓶位置。

3. 保存文件。

使用 Locations 选项卡选择样品瓶位置（可选）
1. 在 Batch Editor 中，打开 Locations 选项卡。

2. 在 Set 列表中，选择集合。

3. 从 Autosampler 列表中，选择自动进样器。

4. 在与支架相关的空间中，右键单击，然后选择支架类型。
样本板或样本盘显示在支架中。

5. 双击带有空格标记的样本架类型。将显示可视化样本架布局。
自动进样器的合适支架空间数量显示在图像支架视图中。

6. 双击其中一个长方形。
显示出表示进样盘或托盘的样品孔或样品瓶的圆圈。

提示! 要在示意图中查看对应的样本瓶号，请将鼠标移至该样本位置上方。通过此信息确
认软件中的样本瓶位置与自动进样器中的样本瓶位置相匹配。
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图 8-5 Locations 选项卡

注释: 基于正在使用的自动进样器，可能无需在其他列中键入详细信息。

7. 若要选择按行还是按列标记样本，单击 Row/Column selection 选择按钮。
如果按钮显示一条红色的水平线，则 Batch Editor 按行标记样本。如果按钮显示一条红色
的垂直线，则 Batch Editor 按列标记样本。

8. 按分析顺序单击样本孔或进样瓶。

提示! 再次单击一个选择的样本孔或样本瓶来移除它。

提示! 若要自动填充样本，请按住 Shift 并单击一个样本集合中的第一个和最后一个样本
瓶。若要由相同的样本瓶进行多次注入，按住 Ctrl，同时单击样本瓶位置。红色圆圈变为
绿色圆圈。

停止样本采集
当样本采集停止时，软件先完成当前扫描，然后才停止采集。

1. 在 Queue Manager 中，单击队列中在采集应该停止的点后的样本。

2. 在导航栏上，单击 Acquire。

3. 单击 Acquire > Stop Sample.
在所选样本的当前扫描采集完之后，采集停止。Queue Manager (Local) 窗口中的样本
状态变化为 Terminated，队列中随后的所有其他样本状态为 Waiting。

4. 如果要继续处理这个批次，单击 Acquire > Start Sample.。

队列状态和设备状态
Queue Manager 会显示队列、批次和样本状态。还可查看关于队列中某一特定样本的详细信
息。

提示! 单击 View Queue ( ) 查看队列。

有关使用 Queue 右键菜单的信息，请参阅以下章节：队列。
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队列状态

队列的当前状态显示在 Queue Server 组中。

图 8-6 显示正常模式的 Queue Server 指示灯

图 8-7 显示调谐模式的 Queue Server 指示灯

第一个图标指示队列的状态。第二个图标指示队列是处于 Tune 模式（适于调谐）还是处于
Normal 模式（适于运行样品）。关于图标和队列状态的描述，请参阅表格：表 8-1。

表 8-1 队列状态

图标 状态 定义

Not
Ready

硬件配置文件被停用，队列不接受任何样本提交。

Stand By 硬件配置文件已被激活，但所有设备都处于闲置状
态。泵未运行，气体被断开。

Warming
Up

正在平衡质谱仪和设备，对柱子进行条件设定以及
清洗自动进样器针头，柱温箱到达预设温度。平衡
的持续时间由操作者选择。从该状态下，系统可以
进入 Ready 状态。

Ready 系统已准备好开始运行样品，设备已达到平衡，并
准备运行。在这种状态下，队列可以接收样品并将
在样品提交后运行。

Waiting 在提交下一样本后，系统将自动开始采集。

PreRun 正在将方法下载到每台设备上，且设备即将达到平
衡。这种状态出现于批次中每个样品的采集之前。
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表 8-1 队列状态 (续)

图标 状态 定义

Acquiring 方法在运行，进行数据采集。

Paused 在采集过程中该系统已暂停。

查看仪器和设备状态图标

位于窗口右下角状态栏上的图标，代表当前激活硬件配置中的质谱仪以及其他每个设备。用户
可以查看 LC 泵的详细状态，从而确保 LC 泵压力合适，或者查看质谱仪的详细状态以监测离
子源的温度。

注释: 对于每一种状态，背景色可以是红色。红色背景表示当处于这种状态时设备出现错误。

在状态栏上，双击设备或质谱仪图标。
Instrument Status 对话框打开。

表 8-2 仪器和设备状态图标

状态 图标 背景色 描述

空闲
 

绿色或黄色 设备没有在工作。如果背景色为黄色，则需
要在设备运行准备就绪之前进行平衡。如果
背景色是绿色，则表示设备运行准备就绪。

正在平衡
 

绿色或黄色 设备正在平衡。

正在等待 绿色 设备正等待来自软件或其他设备的命令，或
者在等待操作者的操作。

正在运行 绿色 设备正在运行一个批次。

正在中止 绿色 设备正在中止一次运行。

正在下载 绿色 一个方法正转移到设备中。

准备就绪 绿色 设备没有在运行，但运行准备就绪。

错误 红色 设备出现错误，需要进行调查。
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操作说明 — 分析和浏览数据 9
使用安装在 Example 文件夹中的样本文件，学习如何使用最常用的分析和处理工具来查看和
分析数据。有关下列主题的更多信息，请参阅文档：《高级用户指南》。

• 标注图

• 覆盖和整合质谱或色谱图

• 执行背景减除

• 平滑算法

• 采用平滑数据运行

• 采用质心数据运行

• 采用轮廓图运行

• 采用碎片解释工具运行

• 采用文库数据库和文库记录运行

打开数据文件

提示! 要关闭质谱的自动更新，右键单击质谱，然后单击 Show Last Scan。如果 Show Last
Scan 有一个复选标记，那么谱图将实时更新。

1. 在导航栏的 Explore 项下，双击 Open Data File。
Select Sample 对话框随即显示。

2. 在 Data Files 列表中，导航到要打开的数据文件，选择一个样本，然后单击 OK。
样本采集数据随即显示。如果仍然在采集数据，那么质谱、二极管阵列检测器/紫外跟踪和
总离子色谱图继续自动更新。

提示! 要查看示例数据文件，确保已选中 Example 项目。打开 TOF 文件夹，然后打开
TOFMS PPGs3000.wiff 文件。在样本列表中，选择 TOFMS。

在数据文件中的样品之间导航

注释: 如果样本保存在不同的数据文件中，则分别打开每个文件。

关于在此程序中使用的导航图标的描述，请参阅表格：表 C-4。

打开包含多个样本的数据文件，然后执行下列操作之一：

• 要跳至数据文件中的下一个样本，请单击 Show Next Sample 图标 ( )。

• 要跳至非序列样本，请单击 Go to Sample 图标 ( )。
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• 在 Select Sample 对话框中，从 Sample 列表选择要查看的样本。

• 要转到数据文件中的前一个样本，请单击 Show Previous Sample 图标 ( )。

查看实验条件
用于收集数据的实验条件与结果一同存储于数据文件中。此信息包含所用下列采集方法的详细
信息：包括仪器参数在内的 MS 采集方法即时段、实验和循环数，以及 LC 设备方法，包括
LC 泵流速。此外，还包含 MS 分辨率和用于样本采集的质量校准表。关于在用户查看文件信
息时可用的软件功能，请参阅以下章节：Show File Information 窗格右键菜单。

注释: 如果将不止一个样本的数据采集到同一个 wiff 文件中，则在用户滚动查看样本时，文件
信息窗格不会自动刷新。关闭文件信息窗格，然后将其再次打开，就可以查看 wiff 文件中下一
个样本的详细信息。

单击 Explore > Show > Show File Information.
File Information 窗格即会在图下方打开。

提示! 要从 File Information 窗格中创建一个采集方法，右键单击 File Information 窗格，然后
单击 Save Acquisition Method。

显示表中数据
1. 打开一个数据文件。

2. 单击 Explore > Show > Show List Data.
数据显示在图下方的窗格中。
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图 9-1 Peak List 选项卡（TripleTOF 系统）

表 9-1 Spectral Peak List 选项卡的右键菜单

菜单 功能

Column Options （列选项）打开 Select Columns for Peak List 对话框。

Save As Text （保存文件）将数据保存为 .txt 文件。

Delete Pane （删除窗格）删除选定窗格。

表 9-2 Chromatographic Peak List 选项卡的右键菜单

菜单 功能

Show Peaks in Graph （在图形中显示峰）在图形中使用两种颜色显示峰。

IntelliQuan Parameters （IntelliQuan 参数）打开 Intelliquan 对话框。

Save As Text （保存为文件）将数据保存为 txt 文件。

Delete Pane （删除窗格）删除选定窗格。
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显示 ADC 数据
从二次检测器中获得模拟数字转换器数据 (ADC)，例如通过 ADC 卡从 UV 检测器中获得，这
些数据可用于与质谱仪数据进行对比。为了使 ADC 数据可用，需要同时获得 ADC 数据和质
谱仪数据。然后将这两种类型的数据保存在相同的文件中。

1. 确保选择存储模拟数字转换器数据的项目文件夹。例如，单击 Example 文件夹。

2. 在导航栏上的 Explore 下，双击 Open Data File。
Select Sample 对话框即会打开。

3. 在 Data Files 字段，双击数据子文件夹（若适用），然后单击要打开的数据文件。例如，
在 Example 文件夹中，双击 Devices，然后单击 Adc16chan.wiff。

4. 在 Samples 列表中选择一个样本，然后单击 OK。

5. 单击 Explore > Show > Show ADC Data。

图 9-2 Select ADC Channel 对话框

6. 在 Channel 列表中选择一个通道，然后单击 OK。

此时会在当前窗格下方出现一个显示 ADC 数据的新窗格。

显示基本的定量数据
1. 打开一个数据文件。

2. 单击 Explore > Show > Show List Data。
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图 9-3 List Data

3. 在 Peak List 选项卡上，右键单击，然后选择 Show Peaks in Graph。
谱峰以两种颜色显示。

4. 要更改峰发现算法的设置，右键单击，然后选择处于激活状态的 Analyst Classic
Parameters 或 Intelliquan Parameters。

5. （可选）删除彩色谱峰，右键单击 Peak List 选项卡，然后清除 Show Peaks in Graph。

色谱图
色谱图是从样本分析中所得数据的图形显示。它将信号强度沿代表时间或扫描次数的轴绘制成
图线。有关处理色谱图时可以用到的软件功能，以及如何使用色谱图窗格右键菜单的更多信
息，请参阅以下章节：色谱图窗格。

软件以每秒次数 (cps) 为单位，按 X 轴所代表的时间，在 Y 轴方向绘制信号强度图线。高于设
定阈值的峰将被自动标记。如果是 LC/MS，色谱图通常作为时间的函数显示。关于色谱图类
型的描述，请参阅表格：表 9-3。

有关使用现有图标的更多信息，请参阅表格：表 9-5。
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表 9-3 色谱图类型

色谱图类型 目的

总离子色谱图
(TIC)

通过绘制一次扫描中所有离子的强度与时间或扫描数关系而产生的色谱
图。

当打开一个数据文件时，预设以总离子色谱图 (TIC) 打开。如果试验只包
含一次扫描，那么它将作为质谱形式出现。

如果在数据文件获取时选中 MCA 复选框，则数据文件以质谱形式打开。
如果没有选中 MCA 复选框，则数据文件以总离子色谱图 (TIC) 打开。

提取离子色谱图
(XIC)

通过从一系列质谱扫描在单个、不连续的质量数或一个质量范围内提取产
生的强度数值而创建的色谱图。它表示一个给定的质量数或质量范围随时
间变化的行为。

基峰色谱图
(BPC)

显示一次扫描中强度最高离子的强度与时间或扫描次数关系的色谱图。

总波长色谱图
(TWC)

汇总所获波长范围内的所有吸光度值，然后按时间对这些值进行标绘，以
此所得的色谱图。它包括在色谱窗格中对时间绘图的一次扫描内所有离子
吸光度的综合情况。

提取波长色谱图
(XWC)

总波长色谱图 (TWC) 的一个子集。提取波长色谱图 (XWC) 显示了单一波
长的吸光度或一系列波长吸光度的综合情况。

二极管阵列检测
器 (DAD)

显示单一或多个波长下的洗脱化合物的吸收光谱的色谱图。

从谱图中显示总离子色谱图
单击 Explore > Show > Show TIC.
会在新窗格中打开 TIC。

提示! 在包含谱图的窗格内右键单击，然后单击 Show TIC。

有关使用 Spectra Panes 右键菜单的信息，请参阅以下章节：谱图窗格

显示来自总离子色谱图的谱图
TIC（总离子色谱图）是通过将一系列质量扫描中所有离子的强度贡献值加总后得出的。使用
TIC 可在单一窗格内查看整个数据集。它通过将一次扫描中所有离子的强度之和作为色谱窗格
中所示时间的函数绘制而得。如果数据中包含来自多个实验的结果，则可以在代表所有实验汇
总结果的 TIC 下方为每一个实验单独创建一个 TIC。

当数据文件打开时，按预设显示为 TIC。不过，如果试验只包含一次扫描，就以质谱方式显
示。如果用户在获取数据文件前选中 MCA 复选框，则数据文件以质谱形式打开。如果没有选
中 MCA 复选框，软件会用 TIC 打开数据文件。

有关使用 Spectra 窗格右键菜单的信息，请参阅以下章节：谱图窗格。
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1. 在含有总离子色谱图的窗格中，选择一个范围。

2. 单击 Explore > Show > Show Spectrum.
谱图显示在一个新窗格中。

提示! 双击 TIC 窗格中的特定时间，以显示谱图。

图 9-4 TIC 示例

生成提取离子色谱图
仅可从单时段、单实验色谱图或谱图生成提取离子色谱图。要从多时段或多实验数据中获得提
取离子色谱图，需通过单击 X 轴下的三角形将数据分成独立的窗格。有关使用现有图标的更多
信息，请参阅表格：表 9-5。

存在多种采用提取离子生成提取离子色谱图的方法，具体取决于使用的是色谱图数据还是波谱
数据。如需在色谱图和质谱图中可使用的方法的摘要，请参阅下表。

表 9-4 提取离子色谱图生成方法总结

方法 使用色谱图 使用质谱图 提取

选择范围 否 是 从谱图中的选定区域提取离子。

最大值 否 是 利用选定区域中的最强峰从谱图中
的选定区域提取离子。此选项将使
用选定谱图范围中的最大质量创建
提取离子色谱图。
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表 9-4 提取离子色谱图生成方法总结 (续)

方法 使用色谱图 使用质谱图 提取

基峰质量 是 是 只能与基峰色谱图 (BPC) 一起使
用。使用 Use Base Peak Masses
命令，在标有针对各质量的不同彩
色描线的提取离子色谱图中提取离
子结果。如果选定范围包括多个
峰，那么所得到的提取离子色谱图
将具有相同数量的彩色描线（每个
质量一条）。

指定质量 是 是 从任何类型的谱图或色谱图中提取
离子。选择多达十个要生成提取离
子色谱图的起始和停止质量。

使用所选的范围生成提取离子色谱图

1. 打开含有谱图的数据文件。

2. 在范围起始处按下鼠标左键，拖动光标到范围终点，然后松开鼠标左键，即可选择范围。
所选范围以蓝色显示。

3. 单击 Explore > Extract Ions > Use Range.
即会在谱图窗格下方的窗格中打开选定范围的提取离子色谱图。窗格顶部的实验信息包含
质量范围和每秒计数的最大强度。

使用最大谱峰生成提取离子色谱图

1. 打开含有谱图的数据文件。

2. 在质谱中选择一个范围。
所选范围以蓝色显示。

3. 单击 Explore > Extract Ions > Use Maximum.
最大峰指定型选择的提取离子色谱图会在谱图窗格下方打开。窗格顶部的实验信息包含质
量范围和每秒计数的最大强度。

采用基峰质量生成提取离子色谱图

1. 打开含有谱图的数据文件。

2. 在基峰色谱图中，选择提取离子的峰。
所选范围以蓝色显示。

3. 单击 Explore > Extract Ions > Use Base Peak Masses.
特定选择的提取离子色谱图会在谱图窗格下方打开。窗格顶部的实验信息包含质量范围和
每秒计数的最大强度。
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通过选择质量来提取离子

1. 打开谱图或色谱图。

2. 单击 Explore > Extract Ions > Use Dialog.

图 9-5 Extract Ions 对话框

3. 键入要创建的每个提取离子色谱图的数值。

• 在 Start 字段中，键入质量范围的开始值（较低值）。

• 在 Stop 字段中，键入质量范围的停止值（较高值）。

注释: 如果没有键入停止值，那么该范围被定义为开始值。

4. 单击 OK。
选定范围的提取离子色谱图会在色谱图窗格下方打开。窗格顶部的实验信息包括质量和每
秒计数的最大强度。

生成基峰色谱图
仅可从单阶段、单实验数据生成基峰色谱图。

1. 打开一个数据文件。

2. 在总离子色谱图内选择一个区域。
所选范围以蓝色显示。

3. 单击 Explore > Show > Show Base Peak Chromatogram.
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所选内容会显示在 Start Time 和 End Time 字段中。

图 9-6 Base Peak Chromatogram Options

4. 在 Mass Tolerance 字段中，键入为寻找谱峰所用质量范围的值。
软件使用达到键入范围两倍的值（±质量值）寻找此峰。

5. 在 Minimum Intensity 字段中键入强度值，低于该值的峰将被算法忽略。

6. 在 Minimum Mass 字段中键入质量值，该值决定扫描范围的起点。

7. 在 Maximum Mass 字段中键入质量值，该值决定扫描范围的终点。

8. 要设置开始和结束时间，选中 Use Limited Range 复选框，执行以下操作：

• 在 Start Time 字段中，键入实验的目标范围的开始时间。

• 在 End Time 字段中，键入实验的目标范围的结束时间。

9. 单击 OK。
新窗格中随即生成基峰色谱图。

生成提取波长色谱图
XWC 是通过取单个波长处的强度值，或通过求一系列波长的吸光度之和而获得的波长色谱
图。可以从二极管阵列检测器谱图中提取多达三个范围，以便生成提取波长色谱图。有关使用
现有图标的更多信息，请参阅表格：表 9-5。

1. 打开包含二极管阵列检测器谱图的数据文件。
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2. 在窗格中的任意位置单击右键，然后单击 Extract Wavelengths。

图 9-7 Extract Wavelengths 对话框

3. 键入 Start 和 Stop 值。

4. 单击 OK。
在二极管阵列检测器谱图下方的窗格中即会打开提取波长色谱图。

显示 DAD 数据
像质谱仪数据一样，二极管阵列检测器数据可以色谱图或谱图形式查看。您可以查看单个时点
的 DAD 质谱，或者某个时间范围的总波长色谱图 (TWC)。

1. 打开含有二极管阵列检测器采集数据的数据文件。
总波长色谱图类似于总离子色谱图，会在总离子色谱图下方的窗格中打开。

2. 在 TWC 窗格中，单击某一点，以选择单一的时间点，或者突出显示谱图的某个区域，以
选择时间范围。

3. 单击 Explore > Show > Show DAD Spectrum.
此时会在总波长色谱图下方的窗格中打开二极管阵列检测器谱图。Y-轴表示吸光度，X-轴
表示波长。

提示! 如果总波长色谱图窗格被关闭，则可以单击总波长色谱图中的任意一点重新将其打
开。单击 Explore > Show > Show DAD TWC.

生成总波长色谱图
TWC 是一种不常使用的色谱图。它将总吸光度 (mAU) 作为时间的函数来显示。TWC 提供了
一种在一个窗格内查看全部数据集的方式。它包括在色谱图中对时间绘图的一次扫描内所有离
子吸光度的综合情况。如果数据中包含来自多个实验的结果，则可以在代表所有实验汇总结果
的 TWC 下方为每一个实验单独创建一个 TWC。

总波长色谱图显示的是相对于 X 轴时间绘制的 Y 轴总吸光度 (mAU)。有关使用现有图标的更
多信息，请参阅表格：表 9-5。

1. 打开包含二极管阵列检测器谱图的数据文件。

2. 单击 Explore > Show > Show DAD TWC.
在二极管阵列检测器谱图下方的窗格中即会显示总波长色谱图。
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提示! 在包含二极管阵列检测器谱图的窗格内单击右键，然后单击 Show DAD TWC。

调整阈值
该阈值是绘制的平行于图形 X 轴的一条隐线，其设置了一个限值，如果低于此值则软件将不会
将峰纳入谱图中。此线具有一个图柄，以 Y 轴左侧的蓝色三角形表示。单击蓝色三角形，查看
表示阈值的虚线。该阈值可以提高或降低，但更改阈值不会改变数据。该软件未标记任何处于
阈值以下区域中的谱峰。

1. 打开一个数据文件。

2. 执行以下任一操作：

• 要提高阈值，沿 Y 轴向上拖动蓝色三角形。

• 要降低阈值，向下拖动蓝色三角形。

• 单击 Explore > Set Threshold. 在打开的 Threshold Options 对话框中，键入阈值，
然后单击 OK。

• 单击 Explore > Threshold.

该图会更新以显示新阈值。峰标记和峰列表也将更新。

提示! 若要查看当前阈值，可将光标移至阈值把手符号上方。

图解数据处理
图解数据可以多种方式进行处理。本部分提供了有关某些最常用工具的使用信息和程序。

图
可通过不同方式来检查图形数据。本部分提供了有关某些最常用功能的使用信息和程序。

在进行如数据平滑或减法处理操作之前，也可保存数据以用于比较。

窗口中包含了一个或多个窗格，所有这些窗格均完全可见，而且互不重叠。

窗格可能大小可变或固定。窗格自动在窗口中平铺，并按列和行格式排列。如果窗口的大小变
化了，则窗口中的窗格大小也发生变化，从而适应新的窗口大小。窗口不能调整至其中的窗格
大小比其最小尺寸还要小的尺寸。

两个或多个包含相似数据的窗口或窗格可以建立链接，例如，有相似质量范围的质谱。当放大
任一窗格或窗口时，其它窗格也同时放大。例如，用户可以将提取离子色谱图 (XIC) 连接至从
中提取该 XIC 的基峰色谱图 (BPC)。放大基峰色谱图 (BPC) 的同时也放大了提取离子色谱图
(XIC)，所以两个色谱图显示出相同的放大率。

管理数据

使用下列菜单选项或图标以管理图中的数据。

操作说明 — 分析和浏览数据
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表 9-5 图选项

目的 使用菜单选项 或单击此图标

将图复制到新窗口 选择要复制的图。单击 Explore > Duplicate
Data > In New Window.

将图恢复到其原始
大小

选择图。单击 Explore > Home Graph.

移动窗格 • 选择图。单击 Window > Move Pane.

• 选择窗格或窗口，然后将其拖动到新的位置。
该位置可以在同一窗口内或在其他窗口中。

当光标位于活动窗口或窗格的边界上，会显示一
个四向箭头。

• 如果窗格位于目标窗格的顶部或底部，那么分
别将窗格移动到目标窗格的上方或下方。

• 如果窗格位于目标窗格的左方或右方，那么分
别将窗格移动到目标窗格的左方或右方。

• 如果窗格位于其他位置，那么将窗格移动到目
标行。随着窗格移动的窗格阴影表示它的新位
置。

链接窗格 a. 在两个图处于打开状态的情况下，单击其中
一个可激活该窗格。

b. 单击 Explore > Link，然后单击另一个窗
格。

删除链接 关闭其中一个窗格。单击 Explore > Remove
Link.

删除窗格 选择图。单击 Window > Delete Pane.

锁定窗格 选择图。单击 Window > Lock Panes.

隐藏窗格 选择图。单击 Window > Hide Pane.

最大化窗格 选择图。单击 Window > Maximize Pane.

平铺窗格 选择图。单击 Window > Tile all Panes.

操作说明 — 分析和浏览数据
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放大 Y 轴
1. 将指针移动到待扩展区域任一侧的 Y 轴左侧，然后按住鼠标左键在垂直方向上拖离起始

点。
沿 Y 轴显示的方框代表新比例。

注释: 对基线进行放大时要小心。放大程度过高，放大框会关闭。

2. 释放鼠标按钮，将图形拖至新比例。

提示! 要使图形 Y 轴恢复原始比例，双击任一个轴。要使整个图形恢复原始比例，单击
Explore > Home Graph.

放大 X 轴
1. 将指针移动到待扩展区域任一侧的 X 轴下方，然后按住鼠标左键在水平方向上拖离起始

点。

2. 释放鼠标按钮，将图形拖至新比例。

提示! 要使图形 X 轴恢复原始比例，双击 X 轴。要使整个图形恢复原始比例，单击
Explore > Home Graph.

操作说明 — 分析和浏览数据
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维修和维护信息 10
定期清洁和维护系统以保持最佳性能。

警告! 触电危险。切勿拆除保护盖。拆除保护盖可能会导致人员受伤或系统故障。
进行例行维护、检查或调整时不需要拆下保护盖。当修理需拆下主盖时，请与
SCIEX 现场服务人员 (FSE) 联系。

警告! 电离辐射危害、生物危害或有毒化学品危害。在清洁或维护质谱仪之前，
确定是否需要去污。如果系统使用了放射性物质、生物制剂或有毒化学品，则
在清洁或维护之前客户必须先消除系统污染。

推荐的维护计划
下面的表格提供了推荐的系统清洁和维护计划。

提示! 定期进行维护工作，保证系统在最佳情况下运行。

• 进行定期气体泄漏测试和常规维护检查，确保系统安全工作。

• 定期清洁系统，使之处于良好的工作条件。

• 在系统维护期间，请仔细检查外部气源系统的部件，包括连接设备的导管，以确认所需条
件已得到满足。更换破裂、夹坏或塌陷的导管。

有关维护离子源信息，请参阅文档：《DuoSpray 离子源操作员指南》。

要确定清洗质谱仪和离子源或进行维护的频率，应考虑以下因素。这些因素会引起质谱仪性能
的变化，说明需要进行维护。

• 检测的化合物

• 样本的洁净度和样本制备方法

• 探针接触样本的时长

• 系统总计运行时间

要订购易耗部件并了解基础维修和维护要求，请联系 QMP 或参阅文档：《部件和设备指
南》。请与 SCIEX 现场服务人员联系，以了解所有其他维修和维护要求。

表 10-1 质谱仪维护任务

组件 频率 任务 了解更多信息

系统 每日 检查泄漏 请参阅以下章节：化学品注意事
项。

维修和维护信息
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表 10-1 质谱仪维护任务 (续)

组件 频率 任务 了解更多信息

气帘板 每日 清洁 请参阅以下章节：清洁气帘板。

低真空泵油 每周 检查油位 请参阅以下章节：检查低真空泵
油位。如有需要，联系当地的合
格维护人员或现场服务人员完成
加油。

低真空泵油 每 3 年，或根
据需要。

更换 联系当地的合格维护人员或现场
服务人员。

低真空泵油 根据需要 加注 联系当地的合格维护人员或现场
服务人员。

锥孔板（前部） 根据需要 清洁 请参阅以下章节：清洁孔板的前
部。

孔板（前面和背面） 根据需要 清洁 联系当地的合格维护人员或现场
服务人员。

QJet 离子导向器 根据需要 清洁 联系当地的合格维护人员或现场
服务人员。

Q0 杆装置和 IQ1 透镜 根据需要 清洁 联系当地的合格维护人员或现场
服务人员。

仪器表面 根据需要 清洁 请参阅以下章节：清洁表面。

离子源废气排放瓶 根据需要 清空 请参阅以下章节：清空离子源废
气排放瓶。

接口加热器 根据需要 更换 联系当地的合格维护人员或现场
服务人员。

表 10-2 离子源维护任务

组件 频率 任务 了解更多信息

TurboIonSpray 和 APCI
探针

根据需要 检查和更换 请参阅文档：《DuoSpray 离子
源操作员指南》。

MICRO 1–50 µL、
MICRO 50–200 µL 和
NANO 探针（OptiFlow
Turbo V 离子源）

根据需要 检查和更换 请参阅文档：《OptiFlow
Turbo V 离子源操作员指南》。

TurboIonSpray 和 APCI
探针的喷针

根据需要 检查和更换 请参阅文档：《DuoSpray 离子
源操作员指南》。

OptiFlow Turbo V 离子
源探针的喷针

根据需要 检查和更换 请参阅文档：《OptiFlow
Turbo V 离子源操作员指南》。
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表 10-2 离子源维护任务 (续)

组件 频率 任务 了解更多信息

电晕放电针 根据需要 更换 请参阅文档：《DuoSpray 离子
源操作员指南》。

Turbo 加热器 根据需要 更换 联系当地的合格维护人员或现场
服务人员。

Turbo 加热器 根据需要 更换 联系当地的合格维护人员或现场
服务人员。

样本导管 根据需要 更换 请参阅文档：《DuoSpray 离子
源操作员指南》。

对于“按需”任务，请遵循以下指导准则：

• 在溢出或质谱仪表面变脏后，清洁质谱仪表面。

• 在离子源废气排放瓶装满前清空该瓶。

• 如果系统的灵敏度降低，清洁孔板、QJet 离子导向器和 Q0 区域。

提示! 定期清洁 Q0 区，以尽量减少放电现象，在很短的时间内相关离子的灵敏度出现明显
降低，对四极杆和透镜的影响。联系合格维护人员或现场服务人员。

• 当油位低于最低水平时，请再向低真空泵注油。

• 定期检查所有排气连接以确保这些连接保持完整，任何排气管都已从客户实验室拆下。

清洁表面
在溢出或质谱仪外表面变脏之后，请清洁质谱仪外表面。

小心: 潜在的系统损坏。只能使用推荐的清洁方法和材料，以避免损坏设备。

1. 用一块浸湿温肥皂水的软布擦拭外表面。

2. 用一块浸湿水的软布擦拭外表面，从而去除任何的肥皂残留。

清洁前端
以下警告适用于本节所有程序：

警告! 高温表面危害。先让 DuoSpray 离子源冷却至少 20 分钟，然后再开始任
何维护程序。离子源和真空接口的某些表面在工作过程中会发烫。

采用日常清洁方法清洁质谱仪前端，以便达到以下目的：

维修和维护信息
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• 最大限度地减少计划外的系统停机时间。

• 保持最佳灵敏度。

• 避免范围更广的清洁（需要上门维修）。

当污染发生时，执行初始日常清洁。清洁至并包括锥孔板的前部。如果日常清洁不能解决灵敏
度问题，可能必须进行一次全面清洁。

本部分提供了关于在不破坏真空环境的情况下执行日常清洁。

注释: 遵守所有适用的地方法规。关于健康与安全指导准则，请参阅章节：化学品注意事项。

污染的症状

如果观察到以下任一情况，则系统可能受到了污染：

• 灵敏度显著降低

• 背景噪音增加

• 全扫描或调查扫描方法中不属于样品的其他谱峰

如果观察到这些问题中的任何一种，即需清洁质谱仪前端。

必需材料

注释: 如需了解订购信息和进行咨询，美国客户可致电 877-740-2129。国际客户可以访问
sciex.com/contact-us。

• 无粉手套（推荐丁腈和氯丁橡胶）

• 护目镜

• 实验室外套

• 新鲜的 LC-MS 级水。陈水可能包含会进一步污染质谱仪的污染物。

• LC-MS 级甲醇、异丙醇（2-丙醇）或乙腈

• 清洗液。请使用下列中的一种：

• 100% 甲醇

• 100% 异丙醇

• 1:1 乙腈：水溶液（新鲜配制）

• 1:1 乙腈：含有 0.1% 醋酸的水溶液（新鲜配制）

• 干净的 1 L 或 500 mL 玻璃烧杯，用于配制清洗液

• 1 L 烧杯，用于接收用过的溶剂

• 有机废弃物容器

• 无绒擦拭巾。请参阅以下章节：制造商可提供的工具和用品。
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• （可选）聚酯棉签

制造商可提供的工具和用品

表 10-3

描述 产品号

小聚酯棉签，热粘合。也包含在清洁套件中。 1017396

无绒擦拭布（11 cm x 21 cm，4.3 英寸 x 8.3 英寸）。也包含在清洁套件
中。

018027

清洁套件。包含小聚酯棉签、无绒擦拭巾、Q0 清洁工具、锥型 QJet 离
子导向器清洁刷和 Alconox。

5020763

清洁最佳做法

警告! 高温表面危害。先让 DuoSpray 离子源冷却至少 20 分钟，然后再开始任
何维护程序。离子源和真空接口的某些表面在工作过程中会发烫。

警告! 有毒化学品危害。在处理、储存和处置化学品时，请参阅化学品安全数据表，并
遵守所有建议的安全规程。

警告! 电离辐射危害、生物危害或有毒化学品危害。在清洁或维护质谱仪之前，
确定是否需要去污。如果系统使用了放射性物质、生物制剂或有毒化学品，则
在清洁或维护之前客户必须先消除系统污染。

警告! 环境危害。请勿按照城市垃圾处置方式来处置系统组件。处理组件时，请遵
循当地法规。

• 拆除离子源前先使其冷却。

• 请始终戴着干净的无粉手套（推荐丁腈和氯丁橡胶）执行清洁程序。

• 在清洁质谱仪组件之后及重新组装之前，戴上一副新的干净的手套。

• 不要使用此程序中未指定的其他清洁用品。

• 如果可能的话，在开始清洁前即行制备清洗液。

• 仅在非常干净的玻璃器皿中制备和储存所有的有机溶液和含有机物的溶液。切勿使用塑料
瓶。污染物可从这些瓶子中浸出并进一步污染质谱仪。

• 为避免污染清洗液，将溶液倒在擦拭布或棉签上。

• 仅用擦拭布的中心区域接触质谱仪表面。切割边缘会留下纤维。

提示! 将擦拭布卷绕在热粘合聚酯棉签上。
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图 10-1 示例：折叠擦拭布

• 为避免交叉污染，擦拭布或棉签触及表面一次之后就应丢弃。

• 如果需要，使用多块擦拭布对真空接口的较大部件（如气帘板）进行多次清洁。

• 应用水或清洗液时，只需稍微沾湿擦拭布或棉签。水往往比有机溶剂更可能造成擦拭布变
质而在质谱仪上留下残留物。

• 不要用擦拭布来回摩擦孔隙。在孔隙周围擦拭，以防止擦拭布的纤维进入质谱仪。

• 不要将刷子插入气帘板或锥孔板的孔隙内。

准备质谱仪

警告! 高温表面危害。先让 DuoSpray 离子源冷却至少 20 分钟，然后再开始任
何维护程序。离子源和真空接口的某些表面在工作过程中会发烫。
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小心: 潜在的系统损坏。卸下离子源时，不得使异物掉入离子源排放口中。

图 10-2 真空接口上的离子源排放

注释: 配有 NanoSpray 离子源的质谱仪可能需要全面清洗以获得最佳效果。联系当地的合格维
护人员或现场服务人员。

1. 停用硬件配置文件。请参阅文档：《软件用户指南》。

2. 取下离子源。请参阅离子源文档：《操作员指南》。

不使用离子源时，请将其存放好，以保护离子源免受损坏，并保持操作的完整性。

清洁气帘板

小心: 潜在的系统损坏。不得用小孔尖端支撑气帘板或锥孔板的重量。气帘板的锥形侧一定要
朝上。

小心: 潜在的系统损坏。为了避免损坏小孔，请勿将金属丝或金属刷插入气帘板、锥孔板或接
口加热器上的小孔。

1. 从真空接口上取下气帘板，然后将其圆锥形的一面朝上，放置在干净、稳定的台面上。

注释: 如果安装了 NANO 池加热器组件，则按照离子源《操作员指南》中的说明将其拆下
并进行清洁。
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图 10-3 气帘板拆除

气帘板通过安装在锥孔板上的三个定位球掣而保持在适当的位置。

提示! 如果气帘板无法立即从锥孔板卸下，则轻微旋转气帘板（小于 90 度）以释放球弹簧
闩。

2. 先用 LC-MS 级水润湿一块无绒布，再清洁气帘板的两侧。

注释: 根据需要，可使用多块擦拭布。

3. 使用清洗液重复步骤 2。

4. 用润湿的擦拭布或聚酯棉签清洁孔隙。

5. 等到气帘板变干燥。

6. 检查气帘板上是否残留了溶剂污渍或绒毛，用干净的微湿的无绒布除去任何残留物。

注释: 一直存在斑点和油膜则说明溶剂受到污染。

清洁孔板的前部

小心: 潜在的系统损坏。清洁锥孔板表面时，请勿卸下接口加热器。频繁卸下接口加热器会导
致其损坏。就日常清洁而言，接口加热器的表面清洗已经足够。

小心: 潜在的系统损坏。为了避免损坏小孔，请勿将金属丝或金属刷插入气帘板、锥孔板或接
口加热器上的小孔。

1. 先用 LC-MS 级水润湿一块无绒布，再擦拭锥孔板前部，包括接口加热器。

2. 使用清洗液重复步骤 1。

3. 等到锥孔板变干燥。

4. 检查锥孔板上是否残留了溶剂污渍或绒毛，用干净的微湿的无绒布除去任何残留物。

维修和维护信息

系统用户指南
RUO-IDV-05-8593-ZH-D

TripleTOF 6600+ 系统
83/127



注释: 一直存在斑点和油膜则说明溶剂受到污染。

使质谱仪重新工作

1. 安装气帘板。

2. 将离子源安装到质谱仪上。请参阅离子源文档：《操作员指南》。

通过将离子源闩向下旋转至锁定位置来固定离子源。

3. 激活硬件配置文件。请参阅文档：《软件用户指南》。

清空离子源废气排放瓶

警告! 高温表面危害。先让 DuoSpray 离子源冷却至少 20 分钟，然后再开始任
何维护程序。离子源和真空接口的某些表面在工作过程中会发烫。

警告! 电离辐射危害、生物危害或有毒化学品危害。将有害物质存放在有标
记的废弃物容器中，并根据当地法规进行处置。

警告! 电离辐射危害、生物危害或有毒化学品危害。请小心将废气排至专门的实
验室通风橱或排气系统，并确保通风管道已用夹子固定牢靠。确保实验室具有
适合所执行工作的适当换气措施。

注释: 确保离子源排废管路没有扭结、松弛或扭曲。

定期检查离子源废气排放瓶，并在其装满前将其清空。同时检查排放瓶和接头有无泄漏，并在
必要时拧紧连接件或更换组件。按照本规程中的步骤清空排放瓶。

1. 取下离子源。请参阅文档：《DuoSpray 离子源操作员指南》。

2. 松开将软管连接到离子源废气排放瓶盖的夹具。
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图 10-4 离子源废气排放瓶

项目 描述

1 通风口连接

2 离子源废气排放管：内径 (i.d.) 2.5 cm（1.0 英寸）

3 低真空泵排气软管：内径为 3.2 cm（1.25 英寸）

4 离子源废气排放瓶
在此图中，加盖的排放瓶显示在质谱仪背面，以便展现连接点。在排放瓶
固定架中，此排放瓶可位于质谱仪一侧。确保瓶子已固定牢靠，以免溢
出。

5 接至质谱仪的离子源废气接口：内径 1.6 cm（0.625 英寸）

6 低真空泵真空入口软管。
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注释: 排放瓶、质谱仪和实验室通风口处的离子源排气软管接头用软管夹固定。

3. 如果适用，将排放瓶拿到固定架外。

4. 从瓶盖上拔下软管。

5. 取下排放瓶上的瓶盖。

6. 清空排放瓶，然后根据实验室规程和当地废弃物法规处置废弃物。

7. 在瓶子上安装瓶盖，然后把瓶子放在支架里。

8. 将软管与瓶盖相连，然后用夹子将软管紧紧固定住。

检查低真空泵油位
检查低真空泵上的视镜，以确认泵油高于最低油位。

如果泵油低于最低油位，则联系合格维护人员 (QMP) 或 SCIEX 现场服务工程师 (FSE)。
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图 10-5 视镜

更换质谱仪冷却风扇过滤器
质谱仪冷却风扇位于质谱仪左侧。

必要程序

• 按照《系统用户指南》中的程序关闭系统。

警告! 环境危害。请勿按照城市垃圾处置方式来处置系统组件。处理组件时，请遵
循当地法规。
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1. 取下冷却风扇盖上的四个翼形螺钉。

图 10-6 冷却风扇过滤器

2. 取下过滤器，换上新的过滤器。
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图 10-7 冷却风扇过滤器

项目 描述

1 冷却风扇盖

2 过滤器

3. 安装过滤器盖。

质谱仪存储和处理

警告! 环境危害。请勿按照城市垃圾处置方式来处置系统组件。处理组件时，请遵
循当地法规。

如果质谱仪须长时间储存或准备装运，那么联系 SCIEX 现场服务工程师，获取关于停止使用
的信息。要断开质谱仪的电源，从交流电源上拔下电源连接器。
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注释: 离子源和质谱仪必须在温度为 –30 °C 至 +60 °C（–22 °F 至 140 °F）、相对湿度不超过
99%（无冷凝）的条件下运输和储存。将系统存放在海拔高度不超过 2,000 m（6,562 英尺）
之处。
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质谱仪故障排除 11
本节包含了对基本系统问题进行故障排除的信息。某些活动只能在实验室中由接受过 SCIEX
培训的合格维护人员 (QMP) 执行。对于高级故障排除，请联系 SCIEX 现场服务人员 (FSE)。

表 11-1 系统问题

症状 可能的原因 纠正措施

QJet Curtain Gas 接口的气体流速
过低。

检查 Curtain Gas 接口的气体
设置，并在需要时升高。

系统发生了故障，因为真空压
力过高。

1. 油位过低。

2. 有泄漏。

3. 安装了错误的锥孔板。

1. 检查低真空泵油位，联系
当地合格维护人员或现场
服务人员完成加油。请参
阅以下章节：检查低真空
泵油位。

2. 检查并修复泄漏。

3. 安装正确的锥孔板。

系统发生了故障，因为 QPS
激发器模块温度过高。

1. 环境温度过高。 1. 联系当地的合格维护人员
或现场服务人员。

2. 有关环境温度规格，请参
阅文档：系统的《场地规
划指南》。

控制软件报告质谱仪因离子源
受损而处于故障状态。

1. 没有安装探针。

2. 探针连接不牢。

确认设备状态面板中故障所在
的详细页面。

1. 安装探针。请参阅文档：
《DuoSpray 离子源操作
员指南》。

2. 拆卸然后安装探针。拧紧
固定环。请参阅文档：
《DuoSpray 离子源操作
员指南》。

控制软件显示正在使用 APCI
探针，但安装的是
TurboIonSpray 探针。

F3 熔断器烧坏。 请联系现场服务人员。

喷射不均匀。 喷针阻塞。 清洁或更换喷针。请参阅文
档：《DuoSpray 离子源操作
员指南》。
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表 11-1 系统问题 (续)

症状 可能的原因 纠正措施

接口加热器未就绪。 接口加热器有故障。 联系当地的合格维护人员或现
场服务人员。

质谱仪分辨率低。 质谱仪未调谐。 使用 Instrument Optimization
向导优化质谱仪。 请参阅
《软件用户指南》或《帮助系
统》。

质谱仪性能下降。 1. 离子源条件未优化。

2. 样本制备不正确或样本品
质下降。

3. 样本进口管件泄漏。

1. 优化离子源条件。请参阅
文档：《DuoSpray 离子
源操作员指南》。

2. 确认样本制备正确。

3. 确认管件大小和类型正确
无误，并确保其结合紧
密。管件请勿过度拧紧。
如仍有泄漏，请更换管
件。

4. 安装并优化替代离子源。

5. 如果问题仍然继续存在，
请联系 FSE。

出现电弧或火花。 电晕放电针的位置不正确。 如果正在使用 TurboIonSpray
探针，则向气帘板旋转电晕放
电针，并使其远离加热器气
流。请参阅文档：
《DuoSpray 离子源操作员指
南》。

表 11-2 灵敏度问题

可能的原因 纠正措施

灵敏度下降

离子源参数未优化。 优化离子源参数。

质谱仪未优化。 使用 Instrument Optimization 向导优化质谱
仪。

气帘板变脏。 清洁气帘板。请参阅以下章节：清洁气帘
板。

锥孔板变脏。 请参阅以下章节：清洁孔板的前部或联系当
地的合格维护人员或现场服务人员。
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表 11-2 灵敏度问题 (续)

可能的原因 纠正措施

QJet 清洁 QJet 离子导向器和 IQ0 透镜。联系当地
的合格维护人员或现场服务人员。

Q0 区域变脏。 Q0 区域污染检测。联系当地的合格维护人员
或现场服务人员。

样本品质下降或浓度低。 验证样本浓度。使用新鲜样本。

未正确安装探针。 拆卸和安装探针。

未正确安装离子源，或离子源有故障。 拆卸和安装离子源，确保妥善固定插锁。如
果问题仍未解决，则安装并优化备用离子
源。

真空接口上的一个或多个 O 形密封圈丢失。 如果 O 形密封圈位于离子源，则将其安装在
真空接口上。如果缺失，则予以更换。

LC（液相色谱）系统或接头有问题。 排查 LC 系统问题。

去簇电压 (DP) 未优化。 优化 DP。

喷针较脏或阻塞。 更换喷针。请参阅文档：《DuoSpray 离子源
操作员指南》。

无信号或信号不稳定

管路堵塞。 更换样本导管。

表 11-3 背景噪声问题

可能的原因 纠正措施

Temperature (TEM)、IonSpray 电压 (IS) 或
加热器的气流速度 (GS2) 过高。

优化离子源参数。请参阅文档：《DuoSpray
离子源操作员指南》。

气帘板变脏。 清洁气帘板。请参阅以下章节：清洁气帘
板。

锥孔板变脏。 清洁锥孔板的前部。请参阅以下章节：清洁
孔板的前部。

QJet 离子导向器或 IQ0 透镜变脏。 全面清洁质谱仪正面组件。联系当地的合格
维护人员或现场服务人员。

Q0 区域变脏。 清洁 Q0 区域。联系合格维护人员或现场服务
人员。

流动相受到污染。 更换流动相。
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表 11-3 背景噪声问题 (续)

可能的原因 纠正措施

离子源被污染。 清洁或更换离子源组件，然后调节离子源和
前端：
1. 沿垂直和水平方向将探针移至距锥孔最远

的位置。

2. （Analyst TF 软件）确保接口加热器状
态为 On。

3. 以 1 mL/min 的泵流速注入或进样 50:50
的甲醇和水。

4. 在控制软件中，将温度设置为 650，将

离子源气体 1 设置为 60，将离子源气体

2 设置为 60。
5. 将 Curtain Gas 接口的气体流速设置为

45 或 50。
6. 运行最少 2 小时或最好隔夜，以达到最

佳效果。

对于销售、技术援助或服务，请联系现场服务人员，或访问 SCIEX 网站 sciex.com 获取联系
信息。
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推荐的校准离子 A
小心: 潜在的错误结果。切勿使用过期溶液或未在指示的储存温度下储存的溶液。

下列表格中列出了 SCIEX 推荐的标准物，用于校准 TripleTOF 6600+ 系统。有关调谐溶液的
信息，请参阅 操作说明 － 调谐和校准。

表 A-1 Q1 PPG 正校准离子

质量

59.0491
4

233.174
72

442.337
40

674.504
84

906.672
28

1196.88
158

1545.13
274

1952.42
576

2242.63
506

表 A-2 Q1 PPG 负校准离子

质量

44.9981
9

411.259
91

585.385
49

933.636
65

1165.80
409

1572.09
711

1863.30
641

1979.39
013

2211.55
757

表 A-3 APCI 正校准液和 ESI 正校准液：TOF MS

TOF MS 质量

氨基庚酸 146.11756

amino-dPEG 4-acid 266.15981

氯米帕明 315.16225

amino-dPEG 6-acid 354.21224

amino-dPEG 8-acid 442.26467

利血平 609.28066

amino-dPEG 12-acid 618.36953

六（2,2,3,3-四氟代丙氧基）膦嗪 922.0098

六（1H,1H,5H-八氟戊氧基）膦嗪 1521.97148

表 A-4 APCI 正校准液和 ESI 正校准液：MSMS（氯米帕明）

MSMS（氯米帕明） 质量

C3H8N 58.0651

C5H12N 86.0964
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表 A-4 APCI 正校准液和 ESI 正校准液：MSMS（氯米帕明） (续)

MSMS（氯米帕明） 质量

C16H14N 220.1121

C14H10NCl 227.0496

C17H17N 235.1356

C15H13NCl 242.0731

C17H17ClN 270.1044

C19H23ClN2 315.16225

表 A-5 APCI 负校准液和 ESI 负校准液：TOF MS

TOF MS 质量

7-氨基庚酸 144.103

amino-dPEG 4-acid 264.14526

磺吡酮碎片 277.09825

amino-dPEG 6-acid 352.19769

磺吡酮 403.11219

amino-dPEG 8-acid 440.25012

amino-dPEG 12-acid 616.35498

amino-dPEG 16-acid 792.45984

表 A-6 APCI 负校准液和 ESI 负校准液：MSMS（磺吡酮）

MSMS（磺吡酮） 质量

C6H5O 93.0344

C6H5OS 125.0067

C10H8NO 158.06114

C17H13N2O2 277.0983

C23H2ON2OS3 403.11219

表 A-7 APCI 负校准液和 ESI 负校准液：MSMS（磺吡酮碎片）

MSMS（磺吡酮碎片） 质量

C6H5 77.03967

C8H6N 116.0506
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表 A-7 APCI 负校准液和 ESI 负校准液：MSMS（磺吡酮碎片） (续)

MSMS（磺吡酮碎片） 质量

C9H8N 130.0662

C10H8NO 158.0611

C11H8N2O2 200.0591

C15H9N2 217.0771

C16H13N2O 249.1033

C17H13N2O2 277.09825
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精确质量和化学式 B
PPG

表 B-1 包含用 PPG（聚丙烯乙二醇）校准液观察到的准确的单同位素质量和带电粒种（正电
和负电）。质量和离子使用公式 M = H[OC3H6]nOH 计算，正离子的 MSMS 碎片使用公式
[OC3H6]n(H+) 计算。在所有计算中，H = 1.007825，O = 15.99491，C = 12.00000，N =
14.00307。

注释: 用 PPG 溶液进行校准时，使用正确的同位素峰。

表 B-1 PPG 精确质量

n 精确质量 (M) (M + NH4)+ MSMS 碎片 (M + NH4)2+ (M + COOH)–

1 76.05242 94.08624 59.04914 56.06003 121.05061

2 134.09428 152.12810 117.09100 85.08096 179.09247

3 192.13614 210.16996 175.13286 114.10189 237.13433

4 250.17800 268.21182 233.17472 143.12282 295.17619

5 308.21986 326.25368 291.21658 172.14375 353.21805

6 366.26172 384.29554 349.25844 201.16468 411.25991

7 424.30358 442.33740 407.30030 230.18561 469.30177

8 482.34544 500.37926 465.34216 259.20654 527.34363

9 540.38730 558.42112 523.38402 288.22747 585.38549

10 598.42916 616.46298 581.42588 317.24840 643.42735

11 656.47102 674.50484 639.46774 346.26933 701.46921

12 714.51288 732.54670 697.50960 375.29026 759.51107

13 772.55474 790.58856 755.55146 404.31119 817.55293

14 830.59660 848.63042 813.59332 433.33212 875.59479

15 888.63846 906.67228 871.63518 462.35305 933.63665

16 946.68032 964.71414 929.67704 491.37398 991.67851

17 1004.72218 1022.75600 987.71890 520.39491 1049.72037

18 1062.76404 1080.79786 1045.76076 549.41584 1107.76223

19 1120.80590 1138.83972 1103.80262 578.43677 1165.80409

20 1178.84776 1196.88158 1161.84448 607.45770 1223.84595

21 1236.88962 1254.92344 1219.88634 636.47863 1281.88781
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表 B-1 PPG 精确质量 (续)

n 精确质量 (M) (M + NH4)+ MSMS 碎片 (M + NH4)2+ (M + COOH)–

22 1294.93148 1312.96530 1277.92820 665.49956 1339.92967

23 1352.9733 1371.0072 1335.9701 694.5205 1397.9715

24 1411.0152 1429.0490 1394.0119 723.5414 1456.0134

25 1469.0571 1487.0909 1452.0538 752.5624 1514.0553

26 1527.0989 1545.1327 1510.0956 781.5833 1572.0971

27 1585.1408 1603.1746 1568.1375 810.6042 1630.1390

28 1643.1826 1661.2165 1626.1794 839.6251 1688.1808

29 1701.2245 1719.2583 1684.2212 868.6461 1746.2227

30 1759.2664 1777.3002 1742.2631 897.6670 1804.2646

31 1817.3082 1835.3420 1800.3049 926.6879 1862.3064

32 1875.3501 1893.3839 1858.3468 955.7089 1920.3483

33 1933.3919 1951.4258 1916.3887 984.7298 1978.3901

34 1991.4338 2009.4676 1974.4305 1013.7507 2036.4320

35 2049.4757 2067.5095 2032.4724 1042.7717 2094.4739

36 2107.5175 2125.5513 2090.5142 1071.7926 2152.5157

37 2165.5594 2183.5932 2148.5561 1100.8135 2210.5576

38 2223.6012 2241.6351 2206.5980 1129.8344 2268.5994

利血平

表 B-2 利血平精确质量 (C33H40N2O9)

描述 质量

分子离子 C33H41N2O9 609.28066

碎片 C23H30NO8 448.19659

碎片 C23H29N2O4 397.21218

碎片 C22H25N2O3 365.18597

碎片 C13H18NO3 236.12812

碎片 C10H11O4 195.06519

碎片 C11H12NO 174.09134

精确质量和化学式
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牛磺胆酸

表 B-3 牛磺胆酸精确质量 (C26H45NO7S)

描述 质量

分子离子 C26H44NO7S 514.28440

碎片 C2H3O3S 106.98084

碎片 C2H6NO3S 124.00739

碎片 SO3 79.95736

TOF 校准液

表 B-4 TOF 校准液精确质量

描述 质量

分子离子 Cs+ 132.90488

分子离子肽 ALILTLVS 829.53933

肽 ALILTLVS

表 B-5 肽 ALILTLVS 精确质量

名称 序列 质量 电荷状态

前体离子 ALILTLVS 829.5393 1+

b8 ALILTLVS 811.5288 1+

b7 ALILTLV 724.4967 1+

b7-18 ALILTLV 706.4862 1+

b6-18 ALILTLV 607.4178 1+

y5 LTLVS 532.3341 1+

b5 ALILT 512.3443 1+

b5-18 ALILT 494.3337 1+

b4 ALIL 411.2966 1+

b3 ALI 298.2125 1+

内部碎片 y|b IL 或 LI 227.1754 1+

内部碎片 y|b LT 或 TL 215.139 1+

b2 AL 185.1285 1+

a2 AL 157.1335 1+

精确质量和化学式
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表 B-5 肽 ALILTLVS 精确质量 (续)

名称 序列 质量 电荷状态

亚胺离子 I 或 L 86.09643 1+

精确质量和化学式
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工具栏图标 C
有关其他工具栏图标，请参阅文档：《高级用户指南》。

表 C-1 工具栏图标

图标 名称 描述

New
Subproject

创建一个子项目。只有在项目最初创建时包含子项目的情况下，
才可在后期创建子项目。

Copy
Subproject

复制子项目文件夹。

只能从既有子项目的项目中复制子项目。如果相同的文件夹在项
目层级和子项目层级中均存在，那么软件会使用项目层级文件
夹。

表 C-2 Acquisition Method Editor 图标

图标 名称 描述

Mass Spec 显示 Acquisition Method 编辑器中的 MS 选项卡。

Period 添加实验 IDA Criteria Level，或删除该时段。

Autosampler 打开 Autosampler Properties 选项卡。

Syringe
Pump

打开 Syringe Pump Properties 选项卡。

Column Oven 打开 Column Oven Properties 选项卡。

Valve 打开 Valve Properties 选项卡。

DAD 打开 DAD Method Editor。请参阅以下章节：显示 DAD 数据。

ADC 打开 ADC Properties 选项卡。请参阅以下章节：显示 ADC 数
据。

表 C-3 Acquire Mode 图标

图标 名称 描述

View Queue 显示样本队列。

工具栏图标
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表 C-3 Acquire Mode 图标 (续)

图标 名称 描述

Instrument
Queue

显示远程仪器站。

Status for
Remote
Instrument

显示远程仪器的状态。

Start Sample 在队列中开始采样。

Stop Sample 在队列中停止采样。

Abort Sample 在样本处理过程中终止样本采集。

Stop Queue 在所有样本的处理完成之前停止队列。

Pause
Sample Now

在队列中插入暂停。

Insert Pause
before
Selected
Sample(s)

在指定样本之前插入暂停。

Continue
Sample

继续采集样本。

Next Period 开始新的时段。

Extend
Period

延长当前时段

Next Sample 停止采集当前样本并开始采集下一样本。

Equilibrate 选择要使用的方法以使设备平衡。此方法应与队列中第一份样本
所用的方法相同。

Standby 将仪器置于 Standby 状态。

Ready 将仪器置于 Ready 状态。

Reserve
Instrument
for Tuning

保留质谱仪进行调谐和校准。

工具栏图标
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表 C-3 Acquire Mode 图标 (续)

图标 名称 描述

Method
Wizard

启动 Method Wizard。

Purge
Modifier

开始清理改性剂泵上的改性剂。

图标 名称 描述

Calibrate
from
spectrum

打开 Mass Calibration Option 对话框并使用当前有效谱图校准
质谱仪。

Manual Tune 打开 Manual Tune Editor。

Instrument
Optimization

验证仪器性能、调整质量校准或调整质谱仪设置。

View Queue 显示样本队列。

Instrument
Queue

显示远程仪器。

Status for
Remote
Instrument

显示远程仪器的状态。

Reserve
Instrument
for Tuning

保留仪器进行调谐和校准。

Purge
Modifier

单击可清理或清除改性剂泵上的改性剂。

表 C-4 查阅快速参考：色谱图和谱图

图标 名称 描述

Open Data
File

打开文件。

Show Next
Sample

转到下一样本。

Show
Previous
Sample

转到前一样本。

工具栏图标
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表 C-4 查阅快速参考：色谱图和谱图 (续)

图标 名称 描述

Go To
Sample

打开 Select Sample 对话框。

List Data 在表格中显示数据。

Show TIC 由谱图生成总离子色谱图。

Extract Using
Dialog

通过选择质量来提取离子。

Show Base
Peak
Chromatogra
m

生成基峰色谱图。

Show
Spectrum

由总离子色谱图生成谱图。

Copy Graph
to new
Window

将当前图表复制到新窗口。

Baseline
Subtract

打开 Baseline Subtract 对话框。

Threshold 调整阈值。

Noise Filter 显示 Noise Filter Options 对话框，可用于界定峰的最小宽度。
此最小宽度以下的信号被视为噪声。

Show ADC 显示模数转换器数据。

Show File
Info

显示数据收集的实验条件。

Add arrows 在当前图表的 X 轴上添加箭头。

Remove all
arrows

移除当前图表 X 轴上的箭头。

Offset Graph 补偿模数转换器数据和质谱仪数据记录过程中的微小差异。在叠
加图表以便比较时，非常有用。

Force Peak
Labels

标记所有的峰。

Expand
Selection By

设置图表某一部分的扩大系数，以进行更详细地查看。

Clear ranges 将扩大的选定部分恢复至正常视图。

工具栏图标
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表 C-4 查阅快速参考：色谱图和谱图 (续)

图标 名称 描述

Set Selection 界定选定部分的起始和终止点。与利用光标进行选择相比，此功
能可更准确地选定所需区域。

Normalize To
Max

依比例将图表调整至最大尺寸，从而使最强的峰扩展至全刻度，
无论其是否可见。

Show History 显示对特定文件执行的数据处理操作汇总，如平滑化、减除、校
准和噪声过滤。

Open
Compound
Database

打开此化合物的数据库。

Set
Threshold

调整阈值。

Show
Contour Plot

以频谱图或提取离子色谱图显示选定数据。此外，对于二极管阵
列检测器所获的数据，等值线图还可通过二极管阵列检测器谱图
或提取波长色谱图显示选定数据。

Show DAD
TWC

生成二极管阵列检测器谱图的总波长色谱图。

Show DAD
Spectrum

生成二极管阵列检测器谱图。

Extract
Wavelength

从二极管阵列检测器谱图中提取三个波长范围以查看提取波长色
谱图。

表 C-5 浏览工具栏快速参考：叠加图形

图标 名称 描述

Home Graph 使图形恢复原始尺寸。

Overlay 叠加图形。

Cycle
Overlays

在叠加图形之间循环。

Sum
Overlays

将图形添加在一起。
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表 C-6 浏览工具栏快速参考：碎片解读工具

图标 名称 描述

Show
Fragment
Interpretation
Tool

打开 Fragment Interpretation 工具，该工具会自动从 mol 文件
计算非环单键裂解碎片。

表 C-7 浏览工具栏上的 Navigation 图标

图标 名称 功能

Open File 打开文件。

Show Next
Sample

导航到下一样本。

Show
Previous
Sample

导航到前一样本。

GoTo Sample 打开 Select Sample 对话框。

List Data 在表格中显示数据。

Show TIC 由谱图生成总离子色谱图。

Extract Using
Dialog

单击后通过选择质量来提取离子。

Show Base
Peak
Chromatogra
m

生成基峰色谱图。

Show
Spectrum

由总离子色谱图生成谱图。

Copy Graph
to new
Window

将当前图表复制到新窗口。

Baseline
Subtract

打开 Baseline Subtract 对话框。

Threshold 调整阈值。

Noise Filter 打开 Noise Filter Options 对话框，在此可定义峰的最小宽度。
此最小宽度以下的信号被视为噪声。

Show ADC 显示模数转换器数据。
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表 C-7 浏览工具栏上的 Navigation 图标 (续)

图标 名称 功能

Show File
Info

显示数据收集的实验条件。

Add arrows 在当前图表的 X 轴上添加箭头。

Remove all
arrows

移除当前图表 X 轴上的箭头。

Offset Graph 补偿模数转换器数据和质谱仪数据记录过程中的微小差异。在叠
加图表以便比较时，非常有用。

Force Peak
Labels

标记所有峰。

Expand
Selection By

设置要仔细观察的局部图形的放大系数。

Clear ranges 将扩大的选定部分恢复至正常视图。

Set Selection 设置选定部分的起始和终止点。这样选择比通过光标勾画区域更
为精确。

Normalize to
Max

按最大尺寸显示图形，这样可以将最强峰扩至全尺寸，无论其是
否可见。

Show History 显示对特定文件执行的数据处理操作汇总，如平滑化、减除、校
准和噪声过滤。

Open
Compound
Database

打开此化合物的数据库。

Set
Threshold

调整阈值。

Show
Contour Plot

以频谱图或提取离子色谱图显示选定数据。此外，对于 DAD 所
采集的数据，等值线图还可通过 DAD 谱图或 XWC 显示选定数
据。

Show DAD
TWC

生成 DAD 的 TWC。

Show DAD
Spectrum

生成二极管阵列检测器谱图。

Extract
Wavelength

从二极管阵列检测器谱图中提取三个波长范围以查看提取波长色
谱图。
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表 C-8 Integration 选项卡和 Quantitation Wizard 图标

图标 名称 描述

Set
parameters
from
Background
Region

使用选定的峰。

Select Peak 使用选定的背景。

Manual
Integration
Mode

对峰进行手动积分。

Show or Hide
Parameters

显示或隐藏找峰参数。

Show Active
Graph

仅显示分析物色谱图。

Show Both
Analyte and
IS

显示分析物及其关联的色谱图。仅当存在关联的内标时才可用。

Use Default
View for
Graph

恢复到预设（查看所有数据）视图（例如，在用户已放大色谱图
的情况下）。

表 C-9 Results Table 图标

图标 名称 描述

Sort
Ascending
by Selection

按升序排列所选的列。

Sort
Descending
by Selection

按降序排列所选的列。

Lock Or
Unlock
Column

锁定或解锁选定的列。无法移动已锁定的列。

Metric Plot
By Selection

从选定列创建度量图表。

Show all
Samples

显示 Results Table 中的所有样本。
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表 C-9 Results Table 图标 (续)

图标 名称 描述

Delete
Formula
Column

删除公式列。

Report
Generator

打开 Reporter 软件。

表 C-10 图标快速参考：定量模式

图标 名称 描述

Add/Remove
Samples

在 Results Table 中添加或移除样品。

Export as
Text

将 Results Table 保存为文本文件。

Modify
Method

打开一个 wiff 文件。

Peak Review
- Pane

在窗格中打开峰。

Peak Review
- Window

在窗口中打开峰。

Calibration -
Pane

在窗格中打开校准曲线。

Calibration -
Window

在窗口中打开校准曲线。

Show First
Peak

在窗格或窗口中显示第一个峰。

Show Last
Peak

在窗格或窗口中显示最后一个峰。

Show Audit
Trail

显示 Results Table 的审核记录。

Clear Audit
Trail

清除 Results Table 的审核记录。此功能不可用。

Statistics 打开 Statistics 窗口。

Report
Generator

打开 Reporter 软件。
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表 C-11 Acquire Mode 图标

图标 名称 功能

Start Sample 单击后在队列中开始采样。

Stop Sample 单击后在队列中停止采样。

Equilibrate 单击后选择一种用于平衡质谱仪的
方法，包括离子源、LC 色谱柱以及
其他可能的外围设备。此方法应与
队列中第一份样本所用的方法相
同。
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右键菜单 D
Batch Editor
右键单击 Batch Editor 表以访问选项。

图 D-1 批次右键菜单

菜单 功能

Open （打开）打开批次文件。

Import From （导入自）从文件导入批次。

Save As Batch （另存为批次）使用不同的文件名保存批次。

Save As a
Template

（另存为模板）将批次保存为模板。

Hide/Show
Column

（隐藏/显示列）隐藏或显示列。

Save Column
Settings

（保存列设置）保存批次列设置。

Add Custom
Column

（添加自定义列）添加自定义列。

右键菜单
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菜单 功能

Delete Custom
Column

（删除自定义列）删除自定义列。

Fill Down （向下填充）复制相同数据至选定单元格。

AutoIncrement （自动递增）在选定单元格中自动递增数据。

Delete Samples （删除样本）删除选定的行。

Select
Autosampler

（选择自动进样器）选择一个自动进样器。

队列
右键单击 Queue 表以访问选项。

图 D-2 Queue Manager 右键菜单

菜单 功能

Sample Details （样本详情）打开 Sample Details 对话框。

Reacquire （再次采集）再次采集一个样本。

Insert Pause （插入暂停）在两个样本之间插入暂停时间（单位为
秒）。

Delete （删除）删除批次或所选择的样本。

Move Batch （移动批次）在队列内移动批次。

Sort （排序）按预选列排序。

Column Settings （列设置）更改列设置。
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Show File Information 窗格右键菜单
表 D-1 Show File Information 窗格右键菜单

菜单 功能

Copy （复制）复制所选数据。

Paste （粘贴）粘贴数据。

Select All （选择所有）选择窗格中的所有数据。

Save To File （保存为文件）将数据保存为 rtf 文件。

Font （字体）更改字体。

Save Acquisition
Method

（保存采集方法）将采集方法保存为 dam 文件。

Save Acquisition
Method to
CompoundDB

（在化合物数据库中保存采集方法）打开 Specify Compound
Information 对话框。选择要在化合物数据库中保存的 ID 和分子
量。

Delete Pane （删除窗格）删除选定窗格。

色谱图窗格
表 D-2 色谱图窗格的右键菜单

菜单 功能

List Data 列出数据点，并对在色谱图中发现的峰进行积分。

Show Spectrum 生成包含谱图的新窗格。

Show Contour Plot 显示一个颜色编码线图数据集，其中颜色表示该点的数据强度。只支
持某些质谱模式。

Extract Ions 从所选窗格中提取一个特定的离子或一组离子，然后生成包含特定离
子色谱图的新窗格。

Show Base Peak
Chromatogram

生成一个包含基峰色谱图的新窗格。

Show ADC Data 生成一个包含 ADC 数据追踪（如已获得）的新窗格。

Show UV Detector
Data

生成一个包含紫外数据追踪（如已获得）的新窗格。

Spectral Arithmetic
Wizard

打开谱图运算向导。

Save to Text File 生成包含窗格中数据的文本文件，此文件可在 Microsoft Excel 或其他
程序中打开。
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表 D-2 色谱图窗格的右键菜单 (续)

菜单 功能

Save Explore
History

在浏览模式下处理 Wiff 文件时，将更改的信息保存到处理参数的步骤
也称为处理选项。处理历史记录存储在一个扩展名为 eph（浏览处理
历史记录）的文件中。

Add Caption 在窗格中的光标位置添加一个标题。

Add User Text 在窗格中的光标位置添加一个文本框。

Set Subtract Range 在窗格中设置减除范围。

Clear Subtract
Range

清除窗格内的减除范围。

Subtract Range
Locked

锁定或解锁减除范围。如果减除范围未被锁定，则每个减除范围均可
独立移动。减除范围预设为锁定状态。

Delete Pane 删除选定窗格。

谱图窗格
表 D-3 谱图窗格的右键菜单

菜单 功能

List Data 列出数据点，并对色谱图进行积分。

Show TIC 生成包含总离子色谱图的新窗格。

Extract Ions (Use Range) 从所选窗格中提取一个特定的离子或一组离子，然后生
成包含特定离子色谱图的新窗格。

Extract Ions (Use Maximum) 利用选定区域中的最强峰提取离子。

Save to Text File 生成窗格的文本文件，可在 Microsoft Excel 或其他程序
中打开。

Save Explore History 在浏览模式下处理 Wiff 文件时，将更改的信息保存到处
理参数的步骤也称为处理选项。处理历史记录存储在一
个扩展名为 eph（浏览处理历史记录）的文件中。

Add Caption 在窗格中的光标位置添加一个标题。

Add User Text 在窗格中的光标位置添加一个文本框。

Show Last Scan 显示选择之前的那次扫描。

Select Peaks For Label 在此对话框中，选择参数，以降低峰值标记。

Re-Calibrate TOF 打开 TOF Calibration 对话框。

Abscissa (Time) 将视图更改为在 x-轴上显示 TOF 值。

Delete Pane 删除选定窗格。

右键菜单
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表 D-3 谱图窗格的右键菜单 (续)

菜单 功能

Add a Record 添加记录和与化合物相关的数据（包括谱图）到库中。
执行此任务需要一个有效的谱图。

Search Library 不设限制条件或利用先前保存的限制条件搜索谱库。

Set Search Constraints 使用 Search Constraints 对话框中键入的标准搜索谱
库。

Results Table
右键单击 Results Table 可访问下表中所示的选项。

表 D-4 Results Table 右键菜单

菜单 功能

Full （全部）显示所有列。

Summary （汇总）显示特定的列。

Analyte （特定分析物）显示特定分析物。

Analyte
Group

（分析物组）创建分析物组。

Sample Type （样本类型）显示特定类型的样本或所有样本。

Add Formula
Column

（添加公式列）添加一个公式列。如果使用了公式列，建议用户对结果进行
验证。

Table
Settings

（表格设置）编辑或选择表格设置。

Query （查询）创建或选择查询。

Sort （排序）创建一个或多个按索引进行的排序。

Metric Plot （度量图表）创建度量图表。

Delete Pane （删除窗格）删除活动状窗格。

Fill Down （向下填充）复制相同数据至选定单元格。

Add Custom
Column

（添加自定义列）添加自定义列。

Delete
Custom
Column

（删除自定义列）删除所选自定义列。

右键菜单
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Peak Review
在 Peak Review 窗口或窗格中右键单击可访问表 D-5 中所示的选项。

表 D-5 峰检查右键菜单

菜单 功能

Options （选项）打开 Peak Review Options 对话框。

Sample
Annotation

（样本标注）打开 Sample Annotation 对话框。

Save Active to
Text File

（将活动保存为文本文件）将所选的峰保存为文本文件。

Show First
Page

（显示第一页）转到第一个样本。

Show Last
Page

（显示最后一页）转到最后一个样本。

Slide Show
Peak Review

（显示峰查看的幻灯片）打开幻灯片显示。

Update Method （更新方法）更新所有峰的算法。

Revert to
Method

（重新确定方法）选择一个根据当前定量方法重新确定的峰。

Delete Pane （删除窗格）删除活动状窗格。

校准曲线
右键单击 Calibration 窗口或窗格可访问下表中所示的选项。

表 D-6 校准曲线右键菜单

菜单 功能

Exclude
(Include)

（排除（包括））右键单击一个点然后单击 Exclude，可从曲线中排除该
点。右键单击一个点然后单击 Include，可将该点计入在内。

Exclude All
Analytes
(Include All
Analytes)

（排除所有分析物（包含所有分析物））右键单击一个点然后单击
Exclude All Analytes，可从曲线中排除所有分析物。右键单击一个点然
后单击 Include All Analytes，可将这些点计入在内。

Show Peak （显示峰）审核单个峰。

Overlay （叠加）叠加两个图形。

Active Plot （活动图表）确定哪个图表为活动状态。

Legend （图例）显示图例。

右键菜单
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表 D-6 校准曲线右键菜单 (续)

菜单 功能

Log Scale X
Axis*

（对数刻度 X 轴）在 X 轴上使用对数刻度。

Log Scale Y
Axis*

（对数刻度 Y 轴）在 Y 轴上使用对数刻度。

Delete Pane （删除窗格）删除活动状窗格。

Home Graph （图形复位）将图形恢复到其原始大小

* 利用对数刻度可在更易于管理的视图中布置数据点，以便可同时监测所有点的影响。在此
视图中，所选的是 Log Scale Y Axis - Log Scale X，而非只对一轴取对数。

右键菜单
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符号词汇表 E
注释: 下表中并非所有符号都可用于每种仪器。

符号 描述

澳大利亚合规标志。表示产品符合澳大利亚通讯与媒体管理局 (ACMA) 的
EMC 要求。

交流电

A 安培（电流）

窒息危险

欧洲共同体授权代表

生物危害

CE 符合性标志

cCSAus 标志。显示加拿大和美国的电气安全认证标志。

目录编号

注意。有关潜在的危害信息，请查阅相关说明。

注释: 在 SCIEX 文档中，此符号表示人身伤害危险。

符号词汇表
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符号 描述

中国有害物质限制使用警示标签。电子信息产品含有一定量的有毒或有害
物质。中间数字是环境友好使用期 (EFUP) 日期，表示产品可正常运行的
日历年数。EFUP 期满后，必须立即回收该产品。循环箭头表示产品可回
收。标签或产品上的日期代码表示生产日期。

中国有害物质限制使用徽标。设备中所含有毒有害物质或元素未超过最高
浓度值，该设备是一种可回收利用的环境友好型产品。

请查阅使用说明。

压碎危险

北美 TUV Rheinland 的 cTUVus 标志

数据矩阵符号，可使用条形码读取器扫描此符号以获得唯一设备标识符
(UDI)

环境危害

以太网连接

爆炸危险

符号词汇表
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符号 描述

眼睛受伤危险

火灾危险

易燃化学危害

易碎

保险丝

Hz 赫兹

国际安全符号“小心，存在触电风险”(ISO 3864)，又称为高压符号
如果必须拆下主盖，请联系 SCIEX 代表，以免触电。

高温表面危险

体外诊断设备

电离辐射危害

保持干燥

请勿淋雨

相对湿度不得超过 99%

保持直立

符号词汇表
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符号 描述

撕裂/切断危害

激光辐射危害

起重危险

磁场危险

制造商

活动部件危害

起搏器危害。不能用于佩戴起搏器的患者。

夹手危险

压缩气体危险

保护接地导线

刺伤危险

活性化学危害

符号词汇表
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符号 描述

序列号

有毒化学品危害

系统运输和保存的适宜压力范围为 66 kPa 至 103 kPa 之间。

系统运输和保存的适宜压力范围为 75 kPa 至 101 kPa 之间。

在指定的最小 (min) 和最大 (max) 相对湿度（无冷凝）范围内运输和储存
系统。

在 –30 °C 至 +45 °C 温度范围内运输和储存系统。

在 –30 °C 至 +60 °C 温度范围内运输和储存系统。

USB 2.0 连接

USB 3.0 连接

紫外线辐射危险

英国合格评定标志

VA 伏安（功率）

V 伏特（电压）

符号词汇表
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符号 描述

WEEE。请勿将设备当作未分类城市废物来处置。环境危害

W 瓦特

XXXX 年 XX 月 XX 日

生产日期

符号词汇表
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警告词汇表 F
注释: 如果任何用于识别组件的标签脱落，请联系现场服务人员 (FSE)。

标签 翻译（如适用）

FOR RESEARCH USE ONLY. NOT FOR
USE IN DIAGNOSTIC PROCEDURES.

仅供研究使用。请勿用于诊断程序。

IMPACT INDICATOR

SENSITIVE PRODUCT WARNING

碰撞指示器

敏感产品警告

注释: 如果指示器倾翻，则说明此容器曾遭丢
弃或者不当处理。在提单上注明，然后检查
是否损坏。任何碰撞损坏的索赔都需要记
录。

IMPORTANT!

RECORD ANY VISIBLE CRATE DAMAGE
INCLUDING TRIPPED “IMPACT
INDICATOR” OR “TILT INDICATOR” ON
THE WAYBILL BEFORE ACCEPTING
SHIPMENT AND NOTIFY YOUR LOCAL AB
SCIEX CUSTOMER SUPPORT ENGINEER
IMMEDIATELY.

DO NOT UNCRATE. CONTACT YOUR
LOCAL CUSTOMER SUPPORT ENGINEER
FOR UNCRATING AND INSTALLATION.

重要！

接受货物之前在运单上记录任何可见的箱体
损毁，包括倾翻的“碰撞指示器”或“倾斜指示
器”，并立即通知当地的 AB SCIEX 客户支持
工程师。

不得打开板条箱。联系当地的客户支持工程
师进行拆箱和安装。

TIP & TELL 倾斜指示器

注释: 指示容器是否倾斜过或经不当处理。写
在提单上，并检查是否有损坏。任何倾斜要
求都需要记录。

TiltWatch PLUS

ShockWatch

倾斜指示器

注释: 指示容器是否倾斜过或经不当处理。写
在提单上，并检查是否有损坏。任何倾斜要
求都需要记录。

警告词汇表
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标签 翻译（如适用）

WARNING: DO NOT OPERATE WITHOUT
FIRST ENSURING BOTTLE CAP IS
SECURED.

警告：在未首先确保瓶盖稳固的情况下，请
勿操作。

注释: 本警告附带在离子源排废瓶上。

WARNING: NO USER SERVICEABLE
PARTS INSIDE. REFER SERVICING TO
QUALIFIED PERSONNEL.

警告：本设备内没有用户可维修的部件。维
修工作应由具有资质的人员完成。

注释: 请查阅使用说明。
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联系我们

客户培训
• 北美地区：NA.CustomerTraining@sciex.com

• 欧洲：Europe.CustomerTraining@sciex.com

• 在欧盟与北美之外请访问 sciex.com/education

在线学习中心
• SCIEX Now Learning Hub

SCIEX 支持
SCIEX 及其代表在全球范围内设有经过系统培训的服务和技术专家。他们可以解答系统问题
或可能出现的任何技术问题。详情请访问 SCIEX 网站 sciex.com 或通过下述方式之一联系我
们：

• sciex.com/contact-us

• sciex.com/request-support

网络安全
有关 SCIEX 产品的最新网络安全指南，请访问 sciex.com/productsecurity。

文档
本版本的文档取代本文档的所有先前版本。

要查看本文档的电子版本，需要 Adobe Acrobat Reader。要下载最新版本，请转到 https://
get.adobe.com/reader。

要查找软件产品文档，请参阅软件随附的版本发布说明或软件安装指南。

要查找硬件产品文档，请参阅系统或组件随附的客户参考 DVD。

最新版本的文档可从 SCIEX 网站上获得，网址：sciex.com/customer-documents。

注释: 如需免费获取本文档的印刷版本，请联系 sciex.com/contact-us。
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